Contents

Contents 3

Before You Begin 7
Before You Read This Book 8
How This Book Is Organized 8
Typographic Conventions 10
Related Documentation 10
  Documentation Available Online 10
  Online Help 12
  Examples 12
  Javadoc Documentation 12
Sun Welcomes Your Comments 13

1. Preparing for Installation 15
  Overview of the Installation 15
  Supported Platforms 17
  System Requirements 17

2. Installing the J2SE, v. 1.4.0 Platform 19
  Determining the Version of Your Current J2SE Platform 19
    Determining If You Need a Solaris Patch 21
Installing the J2SE Platform on Microsoft Windows Systems  21
Installing the J2SE Platform in the Linux Environment  23
Installing the J2SE Platform in the Solaris Operating Environment  26
  Installing Patches in a Solaris 8 Operating Environment  26
  Installing the J2SE, v. 1.4.0 Platform in a Solaris 8 Environment  29
Uninstalling the J2SE, v. 1.4.0 Platform  35

3. **Installing the Sun ONE Studio 4 IDE**  37
Supporting Previous Software Releases  37
Creating a Shared Installation  38
  On Microsoft Windows Systems  38
  In a Solaris or Linux Environment  38
Installing the Sun ONE Studio 4 IDE on the Supported Platforms  39
  Ensuring Sufficient Free Disk Space  39
  Finding the Product Serial Number  39
  Installation on Microsoft Windows Systems  40
  Installation in the Linux Environment  42
  Installation in the Solaris Operating Environments  45
Installing the IDE With the Command-Line Options  48
Finding Installation Subdirectories  52
Uninstalling the Sun ONE Studio 4 IDE  54

4. **Using Your Newly Installed Sun ONE Studio 4 IDE**  55
Setting Up Your Sun ONE Studio 4 IDE  55
Using the Startup Command-Line Options  58

5. **Validating Your Sun ONE Studio 4 Installation**  61
Starting the Default J2EE Reference Implementation Instance  61
Creating a HelloWorld J2EE Application  63
6. Customizing Your Installation 67
   Using Databases With the Sun ONE Studio 4 IDE 67
      Using a PointBase Database 67
      Using Other JDBC Enabled Databases 71
   Configuring your IDE for Web Service Development 72
   Using the IDE’s Internal UDDI Registry Server 72

7. Using the Sun ONE Application Server 7 With the Sun ONE Studio 4 IDE 75
   System Requirements 75
   Installing the Application Server 75
   Connecting the IDE to the Application Server 76
   Installing and Configuring the Application Server Plug-in Module in the IDE 77

8. Using Application and Web Servers With the Sun ONE Studio 4 IDE 79
   Setting Up the WebLogic Environment 79
   Setting the BEA WebLogic Server as the Default Application Server 80
      Starting the WebLogic 7.0 Server From the Sun ONE Studio 4 IDE 81
   Configuring Application Servers for Use With Web Services 81
      Starting Your WebLogic Server from the IDE 82
      Starting Your WebLogic Server from Outside the IDE 82
   Configuring Web Servers for Use With Web Services 83
      Configuring the Tomcat Server 83
      Configuring Web Servers for Use With Native Connector Web Services 85

9. Where to Go From Here 87
   Updating Modules With the Update Center 87
   Other Documentation Resources 88

10. Troubleshooting 89
    Using the solaris_patch_installer 89
Installing the Sun ONE Studio 4 IDE  91
Starting Up the Sun ONE Studio 4 IDE  94
Running Web Services  96
Web Services Using UDDI  98
Using WebLogic Servers 6.1 or 7.0  99
Using J2EE Reference Implementation 1.3.1  100

A.  Solaris Patch Identifications and Descriptions  103

B.  Port Usage in the Sun ONE Studio 4 IDE  105
Before You Begin

This document provides installation instructions for the Sun™ Open Net Environment (Sun ONE) Studio 4 update 1, Enterprise Edition for Java™ integrated development environment (IDE). This product is hereafter referred to as “Sun ONE Studio 4 IDE” or “the IDE.” Topics covered include:

- Overview of the installation steps
- System requirements
- Supported platforms
- Installation of Java 2 Platform, Standard Edition (J2SE™), v. 1.4.0_02
- Application servers and the IDE
- Setting up databases with the IDE
- Contents of top-level directories of the IDE
- Registering with Sun ONE Studio Developer Resources
- Updating modules with the Update Center
- Uninstalling the IDE
- Using the startup command-line switches
- Other documentation resources

See the release notes for a list of environments in which you can create the examples in this book. The release notes are available on this web page:


Screen shots vary slightly from one platform to another. You should have no trouble translating the slight differences to your platform. Although almost all procedures use the interface of the Sun ONE Studio 4 software, occasionally you might be instructed to enter a command at the command line. Here too, there are slight differences from one platform to another. For example, a Microsoft Windows command might look like this:

```
c:>cd MyWorkDir\MyPackage
```
To translate for UNIX® or Linux environments, simply change the prompt and use forward slashes:

```
% cd MyWorkDir/MyPackage
```

---

**Before You Read This Book**

Before you continue with the rest of this guide, you should be familiar with the process of installing and uninstalling software products on the platforms you choose to use with this release of the Sun ONE Studio 4 product. You need familiarity with some system administrative commands, such as:

- `patchadd, pkgadd, patchrm, and pkgrm` utilities in the Solaris™ operating environment
- Add/Remove Program utility on Microsoft Windows systems
- `rpm` command in the Linux environment

If you are unsure about the system administrative commands for your environment or system, contact your system administrator for assistance with the instructions contained in this guide.

**Note** – Sun is not responsible for the availability of third-party web sites mentioned in this document and does not endorse and is not responsible or liable for any content, advertising, products, or other materials on or available from such sites or resources. Sun will not be responsible or liable for any damage or loss caused or alleged to be caused by or in connection with use of or reliance on any such content, goods, or services available on or through any such sites or resources.

---

**How This Book Is Organized**

**Chapter 1** gives an overview of the general installation process and information on system requirements for Sun ONE Studio 4, Enterprise Edition.

**Chapter 2** provides instructions on installing and uninstalling the J2SE, v. 1.4.0_02 platform on your system.
Chapter 3 describes the steps to install the Sun ONE Studio 4 IDE on the supported platforms. The subdirectories installed with the IDE are described and uninstallation instructions are also provided.

Chapter 4 gives instructions on how to start and set up the newly installed Sun ONE Studio 4 IDE. The command-line options are provided and information about product registration is also included.

Chapter 5 steps you through the validation of the Sun ONE Studio 4 IDE installation by using a J2EE™ Reference Implementation 1.3.1 instance during the creation of a simple HelloWorld application.

Chapter 6 provides some information for customizing your IDE installation using the embedded PointBase Restricted Edition 4.2 database and the internal UDDI registry server.

Chapter 7 provides some information about using the Sun ONE Application Server 7 with the IDE.

Chapter 8 gives information on integrating other application servers with the IDE.

Chapter 9 describes steps to update the IDE modules using the Sun ONE Studio Update Center. Information about other documentation resources is also included in this chapter.

Chapter 10 provides you with some troubleshooting hints to assist you with problems you might encounter during the installation and setup process.

Appendix A lists the patches for the Solaris 8 operating environment that are included with the Solaris patch installer for the Solaris operating environment (SPARC™ platform).

Appendix B lists the default port assignments used by the Sun ONE Studio 4 modules, third-party components, and application servers available for use with the IDE.
Typographic Conventions

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Meaning</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>AaBbCc123</td>
<td>The names of commands, files, and directories; on-screen computer output</td>
<td>Edit your .cvspass file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use DIR to list all files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Search is complete.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>What you type, when contrasted with on-screen computer output</td>
<td>&gt; login</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Password:</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Book titles, new words or terms, words to be emphasized</td>
<td>Read Chapter 6 in the User’s Guide.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>These are called class options.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You must save your changes.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Command-line variable; replace with a real name or value</td>
<td>To delete a file, type DEL filename.</td>
</tr>
</tbody>
</table>

Related Documentation

Sun ONE Studio 4 documentation includes books delivered in Acrobat Reader (PDF) format, release notes, online help, readme files for example applications, and Javadoc™ documentation.

Documentation Available Online

The documents described in this section are available from the docs.sun.com™ web site and from the documentation page of the Sun ONE Studio Developer Resources portal (http://forte.sun.com/ffj/documentation).

The docs.sun.com web site (http://docs.sun.com) enables you to read, print, and buy Sun Microsystems manuals through the Internet. If you cannot find a manual, see the documentation index installed with the product on your local system or network.

- Release notes (HTML format)

  Available for each Sun ONE Studio 4 edition. Describe last-minute release changes and technical notes.
• Getting Started guides (PDF format)
  Describe how to install the Sun ONE Studio 4 integrated development environment (IDE) on each supported platform and include other pertinent information, such as system requirements, upgrade instructions, application server instructions, command-line switches, installed subdirectories, database integration, and information on how to use the Update Center.

• Sun ONE Studio 4, Community Edition Getting Started Guide - part no. 817-1144-10
• Sun ONE Studio 4, Enterprise Edition for Java Getting Started Guide - part no. 817-1143-10
• Sun ONE Studio 4, Mobile Edition Getting Started Guide - part no. 817-1145-10

• Sun ONE Studio Programming Series (PDF format)
  This series provides in-depth information on how to use various Sun ONE Studio 4 features to develop well-formed applications for the Java 2 Platform, Enterprise Edition (J2EE™ platform).

• Building Web Components - part no. 816-7869-10
  Describes how to build a web application as a J2EE web module using JavaServer Pages™ (JSP™) technology, servlets, tag libraries, and supporting classes and files.

• Building J2EE Applications - part no. 816-7863-10
  Describes how to assemble Enterprise JavaBeans™ (EJB™) modules and web modules into a J2EE application, and how to deploy and run a J2EE application.

• Building Enterprise JavaBeans Components - part no. 816-7864-10
  Describes how to build EJB components (session beans, message-driven beans, and entity beans with container-managed or bean-managed persistence) using the Sun ONE Studio 4 EJB Builder wizard and other components of the IDE.

• Building Web Services - part no. 816-7862-10
  Describes how to use the Sun ONE Studio 4 IDE to build web services, to make web services available to others through a UDDI registry, and to generate web service clients from a local web service or a UDDI registry.

• Using Java DataBase Connectivity - part no. 816-7870-10
  Describes how to use the JDBC™ productivity enhancement tools of the Sun ONE Studio 4 IDE, including how to use them to create a JDBC application.

• Sun ONE Studio 4 tutorials (PDF format)
  These tutorials demonstrate how to use the major features of each Sun ONE Studio 4 edition.

• Sun ONE Studio 4, Community Edition Tutorial - part no. 816-7868-10
  Provides step-by-step instructions for building a simple J2EE web application.
- **Sun ONE Studio 4, Enterprise Edition for Java Tutorial** - part no. 816-7860-10
  Provides step-by-step instructions for building an application using EJB components and Web Services technology.

- **Sun ONE Studio 4, Mobile Edition Tutorial** - part no. 816-7873-10
  Provides step-by-step instructions for building a simple application for a wireless device, such as a cellular phone or personal digital assistant (PDA). The application will be compliant with the Java 2 Platform, Micro Edition (J2ME™ platform) and conform to the Mobile Information Device Profile (MIDP) and Connected, Limited Device Configuration (CLDC).

You can also find the completed tutorial applications at:
http://forte.sun.com/ffj/documentation/tutorialsandexamples.html

**Online Help**

Online help is available inside the Sun ONE Studio 4 IDE. You can open help by pressing the help key (F1 in Microsoft Windows and Linux environments, Help key in the Solaris environment), or by choosing Help → Contents. Either action displays a list of help topics and a search facility.

**Examples**

You can download examples that illustrate a particular Sun ONE Studio 4 feature, as well as completed tutorial applications, from the Sun ONE Studio Developer Resources portal at:

http://forte.sun.com/ffj/documentation/tutorialsandexamples.html

**Javadoc Documentation**

Javadoc documentation is available within the IDE for many Sun ONE Studio 4 modules. Refer to the release notes for instructions on installing this documentation. When you start the IDE, you can access this Javadoc documentation within the Javadoc pane of the Explorer.
Sun Welcomes Your Comments

Sun is interested in improving its documentation and welcomes your comments and suggestions. Email your comments to Sun at this address:

docfeedback@sun.com

Please include the part number (817-1143-10) of your document in the subject line of your email.
Preparing for Installation

This chapter contains information needed to prepare for the installation of the Sun ONE Studio 4 update 1, Enterprise Edition for Java IDE (hereafter referred to as “Sun ONE Studio 4 IDE” or “the IDE”).

Overview of the Installation

The following steps outline the general process of installing the Sun ONE Studio 4 IDE on your system. This process includes the validation, customization, and registration of your Sun ONE Studio 4 IDE installation:

1. Verify that you have local or network access to either the Java 2 Platform, Standard Edition, v. 1.3.1 (hereafter referred to as “J2SE, v. 1.3.1 platform”) or the Java 2 Platform, Standard Edition, v. 1.4.0_02 (hereafter referred to as “J2SE, v. 1.4.0 platform”) from the system in which you plan to install the Sun ONE Studio 4 IDE.

   Note – The recommended option is the Java 2 Platform, Standard Edition, v. 1.4.0_02 with the Sun ONE Studio 4 IDE. Read Chapter 2 for detailed installation instructions.

2. Verify that the system on which you are installing the Sun ONE Studio 4 software meets the minimum system requirements. See “System Requirements” on page 17 for more information.
3. Determine which software you want the Sun ONE Studio 4 IDE installer to install. The Sun ONE Studio 4 update 1, Enterprise Edition for Java installer includes the following software:

- Core Platform and Modules (required)
- PointBase Server 4.2 Restricted Edition
- J2EE Reference Implementation 1.3.1
- Solaris Developer Modules (available only in Solaris operating environments)

**Note** – The best option is to install the J2EE Reference Implementation 1.3.1 and the PointBase Server 4.2 Restricted Edition with the IDE. These software products are provided to enable you to quickly develop a simple J2EE application, as described in Chapter 5.

4. Determine if you want to keep your previous version of the Sun ONE Studio 4 IDE. If you do, identify a different directory in which to install Sun ONE Studio 4 update 1, Enterprise Edition for Java.

If you want to use the same installation directory as the previous IDE version, you must first uninstall the previous version of the IDE prior to installing Sun ONE Studio 4 update 1, Enterprise Edition for Java.

5. Determine whether you want to keep your current Sun ONE Studio 4 IDE user settings. If you decide to use your current user settings with the new IDE version, you need to specify the location of your current user directory when prompted during the initial IDE setup. Read Chapter 4 for more information.

6. Install Sun ONE Studio 4 update 1, Enterprise Edition for Java. Read Chapter 3 for detailed installation instructions for each of the supported platforms.

7. Set up your initial IDE environment and register the product. Read Chapter 4 for instructions on setting up your user directory and registering the product.

8. Validate your installation of the Sun ONE Studio 4 IDE by starting an instance of the J2EE Reference Implementation 1.3.1 server and creating a simple J2EE application. Read Chapter 5 for additional information.

After you have validated that your Sun ONE Studio 4 IDE installation is working properly, perform the following steps, if desired:

1. Set up the PointBase database server for use with your Sun ONE Studio 4 IDE. Refer to the instructions in Chapter 6.

2. Configure the use of the Sun ONE Studio Application Server 7 or one of the other application servers. Read Chapter 7 and Chapter 8 for more information.
Supported Platforms

Sun ONE Studio 4 update 1, Enterprise Edition for Java has been tested with the following systems:

- Microsoft Windows 2000 Professional system (with latest service packs)
- Microsoft Windows XP Professional system
- Red Hat Linux 7.2
- Sun Linux 5.0
- Solaris 8 operating environment (64-bit, SPARC platform)
- Solaris 9 operating environment (64-bit, SPARC platform)

This release has been tested on a limited basis on the following systems:

- Microsoft Windows NT SP6 systems
- Solaris 8 operating environment (32-bit, SPARC platform)
- Solaris 9 operating environment (32-bit, SPARC platform)

System Requirements

TABLE 1-1 lists the system requirements needed to install a minimum configuration on any of the supported platforms.

<table>
<thead>
<tr>
<th>Supported Platforms</th>
<th>Free Hard Disk Space for User Directory Required for Installation</th>
<th>Free Hard Disk Space Required for Installation</th>
<th>Minimum Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000, Windows XP, Windows NT4 with SP6(^1)</td>
<td>40MB</td>
<td>205 MB</td>
<td>Pentium III, 500 MHz, 512 MB RAM</td>
</tr>
<tr>
<td>Red Hat Linux 7.2, Sun Linux 5.0</td>
<td>40MB</td>
<td>210 MB</td>
<td>Pentium III 500 Mhz, 512 MB RAM</td>
</tr>
<tr>
<td>Solaris 8, Solaris 9 operating environments (64-bit, SPARC platform)</td>
<td>40MB</td>
<td>375 MB</td>
<td>Ultra(^{TM}) 60, 450 MHz, 512 MB RAM</td>
</tr>
<tr>
<td>Solaris 8, Solaris 9 operating environments (32-bit, SPARC platform)(^1)</td>
<td>40MB</td>
<td>375 MB</td>
<td>Ultra 60, 450 MHz, 512 MB RAM</td>
</tr>
</tbody>
</table>
These are general guidelines. Your requirements might vary depending on which additional software you have installed for use with the Sun ONE Studio 4 IDE.
Installing the J2SE, v. 1.4.0 Platform

This chapter gives step-by-step instructions for installing the software for the supported version of the J2SE platform. The supported version of the software is J2SE, v. 1.4.0_02 (hereafter referred to as the “J2SE, v. 1.4.0 platform”) on all the supported platforms. The J2SE, v. 1.4.0 platform includes the Java 2 Software Development Kit, Standard Edition (Java 2 SDK) and the Java 2 Runtime Environment, Standard Edition (JRE).

Before you install the platform, you need to determine whether you have access to a supported version of the J2SE platform on your system.

Determining the Version of Your Current J2SE Platform

To use the Sun ONE Studio 4 IDE, you must have one of the following:

- J2SE, v. 1.3.1 or J2SE, v. 1.4.0_02 platform installed on your system
- Network access to the path in which v. 1.3.1 or v. 1.4.0_02 of the J2SE platform is installed

**Note** – To maximize runtime performance, the J2SE platform should be installed on and accessed from your local system.

Use the following steps to help you determine what you need to do next:

1. **Identify which Java software is available to your system.**
On a Microsoft Windows system, type the following in a command prompt window:

```
C:\>java -version
```

The output looks similar to the following:

```
C:\>java -version
java version "1.4.0"
Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.0-b92)
Java HotSpot(TM) Client VM (build 1.4.0-b92, mixed mode)
```

In a Solaris or Linux environment, type the following:

```
% java -version
```

The output looks similar to the following:

```
% java -version
java version "1.4.0"
Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.0-b92)
Java HotSpot(TM) Client VM (build 1.4.0-b92, mixed mode)
```

If you do have the software installed on your system, review the information on uninstalling the J2SE platform software near the end of this chapter and continue with Chapter 3.

2. If you do not have v. 1.3.1 or v. 1.4.0_02 of the J2SE platform available to your system, you must install the supported J2SE, v. 1.4.0 platform.

   a. Obtain the J2SE, v. 1.4.0_02 installer from
      
      http://www.sun.com/software/sundev/jde/buy/index.html or from
      
      the Sun ONE Studio 4 update 1 companion CD.

   b. Install the J2SE, v. 1.4.0 platform on your system.
      
      Read the following sections for additional instructions for your specific system.
Determining If You Need a Solaris Patch

Even if you have previously installed the J2SE, v. 1.4.0_02 platform, you should use the `solaris_patch_installer` to determine if all the Solaris patches required by the IDE installed in your system.

The `solaris_patch_installer` is provided with the Sun ONE Studio 4 update 1 companion CD and is also available from the Sun ONE Studio 4 update 1 product download page. The installer includes the Solaris patch packages you need to install in your Solaris 8 operating environment. See “Installing Patches in a Solaris 8 Operating Environment” on page 26 for instructions on how to use the `solaris_patch_installer` script.

If the J2SE, v. 1.4.0 platform is already installed on your system, install any Solaris patches that are applicable to your Solaris 8 operating environment.

If you do not have the required Solaris patches when you start the IDE, you receive a message that includes the Solaris patches you need to install on your system. Install the patches on your system or contact your system administrator before proceeding to use the IDE.

**Note** – For a complete list of the Solaris patches included with the `solaris_patch_installer` script, see Appendix A.

Installing the J2SE Platform on Microsoft Windows Systems

**Note** – If you are unsure about installing the J2SE, v. 1.4.0 platform on your Microsoft Windows system, contact your system administrator for assistance.

To install the J2SE, v. 1.4.0 platform on your supported Microsoft Windows system, follow these steps:

1. If you have not already done so, download the `j2sdk-1_4_0_02-windows-i586.exe` installer file from http://www.sun.com/software/sundev/jde/buy/index.html into `j2se-directory` or locate the installer on the Sun ONE Studio 4 update 1 companion CD.
Note – Ensure that the `j2se-directory`, in which you download the software, is located on a disk that has plenty of available space. See “System Requirements” on page 17 for details.

Use the following information if you are accessing the installer file from the download page for the J2SE, v. 1.4.0 platform. Otherwise, proceed to Step 2.

a. In the “Before You Download” section of the
   

   The Java 2 Platform, Standard Edition, v. 1.4.0 Overview page is displayed.

b. Click “Download J2SE v. 1.4 Now!”

   The Java 2 Platform, Standard Edition download page is displayed.

c. From the SDK column of the Download J2SE, v. 1.4.0 table, click DOWNLOAD for Windows (all languages, including English).

   The binary code license agreement is displayed.

d. Read the binary code license agreement carefully. To proceed, accept the terms of the license agreement.

   You must agree to the license to continue with the download. Once you have agreed to the license agreement, the download page is displayed.

e. Click Download `j2sdk-1_4_0_02-windows-i586.exe` to proceed with the download of the file and specify where you want to save the file.

f. Verify that the size of the downloaded file is the same as the file size indicated on the download page.

   This step ensures that you have downloaded the full and uncorrupted software bundle.

2. Uninstall any prerelease versions of the J2SE, v. 1.4.0 platform currently installed on your system.

   If you have previously installed a Beta release or the Release Candidate version of the J2SE, v. 1.4.0 platform, uninstall it. Use the Microsoft Windows Add/Remove Programs utility to uninstall the previous release of the J2SE, v. 1.4.0 platform. Choose Start → Settings → Control Panel to access the utility.

3. Start the installation wizard by double-clicking the `j2sdk-1_4_0_02-windows-i586.exe` file in the `j2se-directory` or from the Sun ONE Studio 4 update 1 companion CD.
Note – You must have administrative permissions to install the J2SE, v. 1.4.0 platform in a Windows XP or Windows 2000 system.

4. Follow the instructions on the wizard panes to complete the J2SE, v. 1.4.0 platform installation on your Microsoft Windows system.

5. (Optional) Delete the downloaded file from the j2se-directory to recover disk space.

Continue to Chapter 3 for instructions on installing the Sun ONE Studio 4 update 1 software.

Installing the J2SE Platform in the Linux Environment

Note – If you are unsure about installing the J2SE, v. 1.4.0 platform in your Linux environment, contact your system administrator for assistance.

To install the J2SE, v. 1.4.0 platform in your supported Linux environment, follow these steps:

1. If you have not already done so, download the j2sdk-1_4_0_02-linux-i586-rpm.bin file into j2se-directory or locate the file on the Sun ONE Studio 4 update 1 companion CD.

   Note – Ensure that the j2se-directory, in which you download the software, is located on a disk that has plenty of available space. See “System Requirements” on page 17 for more information.

Use the following information if you are accessing the installer file from the download page for the J2SE, v. 1.4.0 platform. Otherwise, proceed to Step 2.


The Java 2 Platform, Standard Edition, v. 1.4.0 Overview page is displayed.

b. Click “Download J2SE v. 1.4 Now!”

The Java 2 Platform, Standard Edition download page is displayed.
c. From the SDK column of the Download J2SE, v. 1.4.0 table, click DOWNLOAD for Linux Red Hat.

The binary code license agreement is displayed.

d. Read the binary code license agreement carefully. To proceed, accept the terms of the license agreement.

You must agree to the license to continue with the download. Once you have agreed to the license agreement, the download page is displayed.

e. Click Download j2sdk-1_4_0_02-linux-i586-rpm.bin and specify the directory, j2se-directory, where you want to save the file.

f. Verify that the size of the downloaded file is the same as the file size indicated on the download page.

This step ensures that you have downloaded the full and uncorrupted software bundle.

2. Double-click the j2sdk-1_4_0_02-linux-i586-rpm.bin file on the Sun ONE Studio 4 update 1 companion CD, or type the following commands:

```bash
$ cd j2se-directory
$ chmod a+x j2sdk-1_4_0_02-linux-i586-rpm.bin
$ j2sdk-1_4_0_02-linux-i586-rpm.bin
```

The script displays the binary license agreement.

3. Read the binary license agreement carefully. To proceed, accept the terms of the license agreement.

You must agree to the license to continue with the installation.

Once you have agreed to the license agreement, the install script creates the j2sdk-1_4_0_02-linux-i586-rpm file in the current directory.

4. Become a superuser (root) by typing the following in a terminal window:

```bash
$ su
Password: root-password
```

5. Uninstall any prerelease versions of the J2SE, v. 1.4.0 platform currently installed on your system.

If you have previously installed a Beta release or the Release Candidate version of the J2SE, v. 1.4.0 platform, uninstall it.
Chapter 2 Installing the J2SE, v. 1.4.0 Platform

Note – The default installation location for the prerelease versions of the J2SE platform is /usr/java/j2sdk1.4.0. That is the same location in which the RPM package of the final version of the J2SE, v. 1.4.0 platform is installed. To clear the way for installation of the final version of the J2SE, v. 1.4.0 platform, you must first uninstall any of these previous releases that you have installed. Skip this step if you have not installed any of these previous releases.

If you are not sure if you have a prerelease version installed in your system, run the following command:

```
# rpm -query -a | grep j2sdk-1.4.0
```

The output displays the RPM package name of the prerelease version of the J2SE, v. 1.4.0 platform. For example, if the J2SE 1.4.0 Beta 3 version is installed, the command returns the RPM package name for Beta 3, which is j2sdk-1.4.0-beta3.

If you determine that a Beta package is installed, uninstall it using the `rpm` command. For example, to remove the Beta 3 version of the J2SE, v. 1.4.0 platform, type the following:

```
# rpm -e j2sdk-1.4.0-beta3
```

6. Run the `rpm` command to install the package for the J2SE, v. 1.4.0 platform by typing the following:

```
# cd j2se-directory
# rpm -iv j2sdk-1.4.0_02-linux-i586.rpm
```

The packages for the J2SE, v. 1.4.0 platform are installed in /usr/java/j2sdk1.4.0.

7. Exit from your superuser privileges by typing:

```
# exit
```

Continue to Chapter 3 for instructions on installing the Sun ONE Studio 4 update 1 software.
Installing the J2SE Platform in the Solaris Operating Environment

You must first install any Solaris patches required in your Solaris 8 operating environment (SPARC platform) before proceeding with the installation of the J2SE, v. 1.4.0 platform. Use the steps in the next section to guide you in the installation of the Solaris patches and the J2SE, v. 1.4.0 platform.

**Note** – The Solaris 9 environment is preconfigured with the J2SE, v1.4.0 platform. To install the J2SE, v.1.4.0_02 platform, download the latest patches from [http://www.java.sun.com/j2se/1.4/download.html](http://www.java.sun.com/j2se/1.4/download.html) and follow the directions provided for installing the J2SE, v.1.4.0_02 platform in a Solaris 8 operating environment.

Installing Patches in a Solaris 8 Operating Environment

**Note** – If you are unsure about installing Solaris patches in your Solaris environment, contact your system administrator for assistance.

These instructions describe how to install the necessary Solaris patches prior to the installation of the J2SE, v. 1.4.0 platform. These instructions are applicable only in a Solaris 8 operating environment. Refer to Appendix A for a list of the Solaris patches included with the `solaris_patch_installer`.

1. **If you have not already done so, download the** `solaris_patch_installer.tar.gz` **file into the** `solaris-patches-directory` **from the Sun ONE Studio download web site at** [http://www.sun.com/software/sundev/jde/buy/index.html](http://www.sun.com/software/sundev/jde/buy/index.html) **or from the Sun ONE Studio 4 update 1 companion CD.**

**Note** – Ensure that the `solaris-patches-directory`, in which you download the software, is located on a disk that has plenty of available space. See “System Requirements” on page 17 for details.
2. From the solaris-patches-directory, uncompressed and extract the contents of the downloaded file by typing:

```
% cd solaris-patches-directory
% gzip solaris_patch_installer.tar.gz | tar xvf -
```

**Note** – The gzip utility can be found in the /usr/bin directory in the Solaris 8 operating environment.

The solaris_patch_installer file and the patches directory are extracted in the solaris-patches-directory. The patches directory contains several subdirectories for each of the required Solaris patches.

3. (Optional) To recover disk space, remove the downloaded file by typing:

```
% rm -rf solaris_patch_installer.tar.gz
```

4. Become a superuser (root) by typing the following in a terminal window:

```
% su
Password: root-password
```

5. Go to the solaris-patches-directory and run the solaris_patch_installer script:

```
# cd solaris-patches-directory
# ./solaris_patch_installer
```

The solaris_patch_installer determines which patches that are necessary for the installation of the J2SE, v. 1.4.0 platform have already been applied and which patches still need to be installed.
6. (Optional) After the patch installation is complete, look at the
/var/tmp/solaris_patch_installer.log file for more details about the
installation.

Note – Some Solaris patches require that you reboot your system after installation
has completed. The installer prompts you to reboot, if necessary.

7. When prompted, reboot your system by typing y:

```
# ./solaris_patch_installer
Solaris Patch Installer for J2SE, v.1.4.0
Installing 109147-14...already applied
Installing 108434-06...successfully installed
Installing 108435-06...successfully installed
Installing 111293-04...attempting to patch a package that is not
installed
Installing 112334-01...already applied
```

8. If you are not prompted to reboot, exit from your superuser privileges by typing:

```
# exit
```

9. (Optional) After you log back on to your system, remove the solaris-patches-directory
and its contents to recover disk space. Type the following:

```
% rm -rf solaris-patches-directory
```
Installing the J2SE, v. 1.4.0 Platform in a Solaris 8 Environment

**Note** – If you are unsure about installing Solaris packages or the J2SE, v. 1.4.0 platform in your Solaris environment, contact your system administrator for assistance.

Prior to installing the J2SE, v. 1.4.0 platform, you must ensure that you have installed the full set of required patches needed to support v. 1.4.0 of the J2SE platform in your Solaris 8 environment. See “Installing Patches in a Solaris 8 Operating Environment” on page 26 for more information.

To install the 64-bit J2SE, v. 1.4.0 platform in your 64-bit Solaris 8 environment, you must follow a two-step procedure:

1. **Install the 32-bit J2SE, v. 1.4.0 platform in your 64-bit Solaris 8 environment.**
   Follow the instructions in the next section for more information.

2. **Install the J2SE, v. 1.4.0 supplemental release for 64-bit operation in your 64-bit Solaris 8 environment.**
   Use the instructions in “Installing the J2SE, v. 1.4.0 Supplemental Release for 64-bit Operation in a Solaris 8 Environment” on page 32 for more information.

Installing the J2SE, v. 1.4.0 Platform in a 32-bit Solaris 8 Environment

**Note** – If you are unsure about installing Solaris packages or the J2SE, v. 1.4.0 platform in your Solaris environment, contact your system administrator for assistance.

Follow these steps to install the J2SE, v. 1.4.0 platform in your supported Solaris operating environment using the `pkgadd` command:

1. **If you have not already done so, download the `j2sdk-1_4_0_02-solaris-sparc.tar.Z` file into the `j2se-directory`. You can also obtain the file from the Sun ONE Studio 4 update 1 product CD.**
**Note** – Ensure that the *j2se-directory*, in which you download the software, is located on a disk that has plenty of available space.

If you are accessing the installer file from the Sun ONE Studio 4 update 1 product CD, skip to Step e.

a. **In the “Before You Download” section of the**
   
   
   The Java 2 Platform, Standard Edition, v. 1.4.0 Overview page is displayed.

b. **Click “Download J2SE v. 1.4 Now!”**
   
   The Java 2 Platform, Standard Edition download page is displayed.

c. **From the SDK column of the Download J2SE, v. 1.4.0 table, click DOWNLOAD for Solaris SPARC 32-bit tar.Z.**
   
   The binary code license agreement is displayed.

d. **Read the binary code license agreement carefully. To proceed, accept the terms of the license agreement.**
   
   You must agree to the license to continue with the download. Once you have agreed to the license agreement, the download page is displayed.

e. **Click Download j2sdk-1_4_0_02-solaris-sparc.tar.Z from the product download page or obtain the file on the Sun ONE Studio 4 update 1 product CD, and save the file to the *j2se-directory*.**

f. **Verify that the size of the downloaded file is the same as the file size indicated on the download page or from the Sun ONE Studio 4 update 1 product CD.**
   
   This ensures that you have downloaded the full and uncorrupted software bundle.

2. **From the *j2se-directory*, uncompress and extract the contents of the downloaded installer file by typing the following at the command line:**

   ```
   % cd j2se-directory
   % zcat j2sdk-1_4_0_02-solaris-sparc.tar.Z | tar xvf -
   ```

   This action creates several packages (*SUNWj3dmo*, *SUNWj3dev*, *SUNWj3man*, *SUNWj3rt*, plus *SUNWj3jmp* for Japanese man pages) along with the product license, readme file, and other release documentation.
3. Become a superuser (root) by typing the following in a terminal window:

```
% su
Password: root-password
```

4. Uninstall your previous installation of the J2SE platform, if needed.

**Note** – The default installation location for versions 1.3.0, 1.3.1, and the previous 1.4.0 Beta release of the J2SE platform is `/usr/j2se`. That is the same location in which J2SE, v. 1.4.0 is installed. To clear the way for installation of the J2SE, v. 1.4.0 platform, you must first uninstall any of these previous releases that you have installed. Skip this step if you have not installed any of these previous releases or if you intend to install J2SE, v. 1.4.0 in a nondefault location.

If you have previously installed the packages for J2SE versions 1.3.0, 1.3.1, or 1.4.0 prereleases, remove them by using the *pkgrm* command:

```
# pkgrm SUNWj3dmo SUNWj3man SUNWj3dev SUNWj3rt
```

If you have previously installed packages `SUNWlj3dv` and `SUNWlj3rt` for localization support in version 1.3.0, remove them by using the following command:

```
# pkgrm SUNWlj3dv SUNWlj3rt
```

If you have previously installed the Japanese man page packages for the Java 2 SDK v. 1.3.0 or v. 1.3.1, remove them by using the following command:

```
# pkgrm SUNWjej3m SUNWjpj3m SUNWjuj3m
```

If your `/usr/java` symbolic link was pointing to the Java 2 SDK v. 1.2.2 installation at `/usr/java1.2`, you might want to update it to point to `/usr/j2se`, which is the location where the Java 2 SDK v. 1.4.0 will be installed.
5. Run the `pkgadd` command to install the packages:

```bash
# cd j2se-directory
# pkgadd -d . SUNWj3rt SUNWj3dev SUNWj3man SUNWj3dmo
```

The J2SE v. 1.4.0 packages are installed into `/usr/j2se`. Refer to the `pkgadd(1)` and `admin(4)` man pages for information on installing the J2SE, v. 1.4.0 in a nondefault location.

6. (Optional) Remove the `j2se-directory` to recover disk space:

```bash
# rm -rf j2se-directory
```

7. Exit from your superuser privileges by typing:

```bash
# exit
```

If you need to install the J2SE, v. 1.4.0 supplemental release platform, continue to the next situation for more information.

Otherwise, continue to Chapter 3 for instructions on installing the Sun ONE Studio 4 update 1 software.

---

Installing the J2SE, v. 1.4.0 Supplemental Release for 64-bit Operation in a Solaris 8 Environment

**Note** – If you are unsure about installing Solaris packages or the J2SE, v. 1.4.0 platform in your Solaris environment, contact your system administrator for assistance.

Follow these steps to install the 64-bit supplemental release of the J2SE, v. 1.4.0 platform in your Solaris 8 environment:

1. **If you have not already done so, download the** `j2sdk-1_4_0_02-solaris-sparcv9.tar.Z` **file into the** `j2se-64bit-directory`. **You can also obtain the file from the Sun ONE Studio 4 update 1 companion CD.**
Note – Ensure that the jse-64bit-directory, in which you download the software, is located on a disk that has plenty of available space.

If you are accessing the installer file from the Sun ONE Studio 4 update 1 companion CD, skip to Step e.


The Java 2 Platform, Standard Edition, v. 1.4.0 Overview page is displayed.

b. Click “Download J2SE v. 1.4 Now!”

The Java 2 Platform, Standard Edition download page is displayed.

c. From the SDK column of the Download J2SE, v. 1.4.0 table, click DOWNLOAD for Solaris SPARC 64-bit tar.Z.

The binary code license agreement is displayed.

d. Read the binary code license agreement carefully. To proceed, accept the terms of the license agreement.

You must agree to the license to continue with the download. Once you have agreed to the license agreement, the download page is displayed.

e. Click Download j2sdk-1_4_0_02-solaris-sparcv9.tar.Z from the product download page or obtain the file from the Sun ONE Studio 4 update 1 companion CD, and specify where you want to save the file.

f. Verify that the size of the downloaded file is the same as the file size indicated on the download page or from the Sun ONE Studio 4 update 1 companion CD.

This step ensures that you have downloaded the full and uncorrupted software bundle.

2. From the j2se-64bit-directory, uncompress and extract the contents of the downloaded installer file by typing the following at the command line:

```
% cd j2se-64bit-directory
% zcat j2sdk-1_4_0_02-solaris-sparcv9.tar.Z | tar xvf -
```

This action creates several packages (SUNWj3dvx, SUNWj3rtx, and SUNWj3dmx) that contain 64-bit support for the J2SE, v. 1.4.0 platform.
3. Become a superuser (root) by typing the following in a terminal window:

```
% su
Password: root-password
```

4. Uninstall your Beta installation of the 64-bit packages for the J2SE, v.1.4.0, if needed.

If you have previously installed the Beta release of packages SUNWj3dvx, SUNWj3rtx, and SUNWj3dmx for 64-bit support, remove them by using the `pkgrm` command:

```
# pkgrm SUNWj3rtx SUNWj3dvx SUNWj3dmx
```

5. Run the `pkgadd` command to install the packages:

```
# cd j2se-64bit-directory
# pkgadd -d . SUNWj3rtx SUNWj3dvx SUNWj3dmx
```

This action installs the files for 64-bit support into the J2SE v. 1.4.0 installation at `/usr/j2se`.

6. (Optional) Remove the `j2se-64bit-directory` to recover disk space:

```
# rm -rf j2se-64bit-directory
```

7. Exit from your superuser privileges by typing:

```
# exit
```

Continue to Chapter 3 for instructions on installing the Sun ONE Studio 4 update 1 software.
Uninstalling the J2SE, v. 1.4.0 Platform

Use the following information to uninstall the J2SE, v. 1.4.0 platform:

- In a Microsoft Windows system, use the Add/Remove Programs utility in the Control Panel to uninstall the J2SE, v. 1.4.0 platform from your system.
- For a Linux environment, use the `rpm` command to uninstall the J2SE, v. 1.4.0 platform from your system.
- For Solaris operating environments, use the `pkgrm` and `patchrm` commands to uninstall the J2SE, v. 1.4.0 platform and associated Solaris patches from your system.

Caution – Removing the J2SE, v. 1.4.0 software and related Solaris patches can cause regressive behavior on your system. Contact your system administrator if you are unsure of how to remove the Solaris, J2SE v. 1.4.0 platform and associated Solaris patches from your system.

Refer to the `pkgrm` and `patchrm` man pages for additional information on these commands.
CHAPTER 3

Installing the Sun ONE Studio 4 IDE

This chapter provides step-by-step instructions on how to install your Sun ONE Studio 4, Enterprise Edition for Java software from the product CD or from files downloaded electronically from the web. It contains installation instructions for each of the supported platforms. The subdirectories installed with the IDE are described, and uninstallation instructions are also provided.

You can install Sun ONE Studio 4, Enterprise Edition for Java as a standalone product or as part of a suite of products that includes the Sun ONE Studio software. When you install using the Sun One Studio 4 update 1 product CD, you can select the product configuration during the installation. If you acquire this software as part of an electronic download, the product selection is already set for you when you start the installer.

Supporting Previous Software Releases

To upgrade your previous version of the Forte™ for Java IDE to Sun ONE Studio 4 software, you must do one of the following:

- **Determine if you want to keep your previous version of the IDE.** If you do, identify a different directory in which to install the Sun ONE Studio 4 software.
  
  If you want to use the same installation directory as the previous IDE version, you must first uninstall the previous version of the IDE prior to installing Sun ONE Studio 4 software.

- **Determine whether you want to keep your current IDE user settings.** If you decide to use your current user settings with the new IDE version, you need to specify the location of your current user directory when prompted during the initial IDE setup. Read Chapter 4 for more information.
Creating a Shared Installation

If you want to share a Sun ONE Studio installation between multiple users, you must install the Sun ONE Studio 4 IDE into a shared directory.

On Microsoft Windows Systems

After installation of the IDE on a Microsoft Windows system, you must set your own user directory using a dialog box that appears immediately upon initial startup of the IDE from your machine. This placement occurs for both shared and unshared installations.

In a Solaris or Linux Environment

After installation of the IDE in the supported Solaris environment or Linux environment, all user settings are stored in the `s1studio-user-directory` created under each user’s home directory. This occurs for both shared and unshared installations.

To use the IDE with a Sun Ray™ appliance, take the following steps:

1. **Install the Sun ONE Studio IDE in a directory that is network-shared.** (For example; `/net/my-machine/my-shared-dir/s1studio/ee`).

2. **Log in to your Sun Ray appliance and start the IDE.**

3. **Start the J2EE RI server instance.**
   a. Expand the Server Registry and Installed Server nodes from the Runtime tab of the Explorer window
   b. Expand the J2EE RI 1.3.1 node.
   c. Right-click RI Instance 1 and choose Start Server from the contextual menu.

Normally, the RI server instance should start properly. You might see the following error:

```
Error: FORTE4J_HOME environment variable does not point to your Forte For Java installation. Please set this variable to point to your Forte For Java installation.
```
If you see this error, modify FORTE4J_HOME environment variable in $HOME/s1studio-user-directory/j2sdkee1.3.1/bin/userconfig.sh to point to /net/my-machine/my-shared-dir/s1studio/ee.

If several users are starting and using the J2EE RI server on the same Sun Ray server, you might have to change the ports used by some of the RI services, such as the HTTP, HTTPS, EJB, and Naming and Directory services. If you are using the PointBase or Tomcat server in a multiuser environment, you might have to change the pertinent default port numbers. Refer to Appendix B, TABLE B-1 for details.

---

**Installing the Sun ONE Studio 4 IDE on the Supported Platforms**

These instructions describe the installation process for each of the supported platforms.

You can install the Sun ONE Studio 4 IDE in two ways:

- Use the graphical user interface (GUI) installer, described in “Installing the Sun ONE Studio 4 IDE on the Supported Platforms” on page 39.
- Perform a command-line installation if you do not have graphical user interface capabilities or do not want to use them. See “Installing the IDE With the Command-Line Options” on page 48.

---

**Ensuring Sufficient Free Disk Space**

Running the installer requires 50 megabytes of free disk space in the /tmp directory on the computer that contains the product CD-ROM. Ensure that you have this space available before starting the installation process. This requirement applies to all the supported platforms.

---

**Finding the Product Serial Number**

When you purchase the product, the serial number is listed on a card enclosed in the product package. That serial number is the number you type in the Enter Serial Number pane of the installer during installation. You can also generate a 60-day trial license serial number during the installation process.
Installation on Microsoft Windows Systems

You can install the Sun ONE Studio 4 IDE on a supported Microsoft Windows system by using the GUI installer on the product CD or by downloading an .exe file from the product download web page.

Note – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed on your system before installing the Sun ONE Studio 4 IDE. The recommended option is the J2SE, v. 1.4.0_02 platform with the Sun ONE Studio 4 IDE. Read Chapter 2 for instructions on installing the software.

1. Start the installation.
   - If you are installing the IDE from a CD, insert the Sun ONE Studio 4 update 1 product CD. The Product Selection pane appears.
     - If the installer does not start, the auto run feature might be disabled. Follow these steps:
       a. Click Start, click Run, and browse to the CD directory.
       b. Select setup.exe and click OK.
       c. Click Run (or double-click setup.exe).
       - Write down the serial number provided in the Sun ONE Studio 4 product package.
       - If you are performing a web installation and have not already done these tasks, you must:
         b. Save the file into the s1studio-download-directory.
         c. Write down the serial number provided to you on the download page.
         d. Double-click the ffj_ei_win32_en.exe file in the s1studio-download-directory. The Welcome screen appears.
         e. Skip to Step 4.
   
   Note – If you encounter errors at any point during the Sun ONE Studio 4 IDE installation, refer to Chapter 10 for some troubleshooting hints.

2. From the Product Selection pane, select Sun ONE Studio 4 update 1, Enterprise Edition for Java.
   - A brief description of this edition of the IDE appears under the list of products.
3. Click Install.

Note – During the installation process, the installation wizard displays a blue Sun ONE Studio pane with text that states “Launching and Running Installer.” Other installation panes appear in the foreground. Do not close either pane. If you bring the larger blue pane to the foreground, it might hide the secondary installation pane. Keep both panes visible, with the larger blue pane behind the smaller pane.

4. When the InstallShield Wizard’s welcome screen appears, click Next to continue. The license agreement pane appears.

5. Read the license agreement carefully. To proceed, accept the terms of the license agreement, and click Next.

You must agree to the license to continue with the installation.

The installer attempts to locate a compatible Java 2 SDK v. 1.3.1 or v. 1.4.0 on your system.

6. Set the location of compatible Java 2 SDK software and click Next.

The Sun ONE Studio 4 IDE requires local or network access to either v. 1.3.1 or v. 1.4.0 of the Java 2 SDK software. Specify which installed software to use.

7. Accept the default installation folder, or click Browse to install the IDE in a different directory. Click Next to continue.

8. Specify a serial number by doing one of the following, and click Next to continue with the installation.

   - If you have been provided with a serial number in the Sun ONE Studio 4 product CD or as part of the electronic download process, type the number in the designated text field.
   - Click 60 day trial to generate a serial number that expires in 60 days. Write down the trial serial number that appears.

   The trial serial number gives you access to the Update Center services once you have registered the product. Read Chapter 4 for product registration information and see “Updating Modules With the Update Center” on page 87 for information on the Sun ONE Studio Update Center.

9. Accept the default installation folder, or click Browse to install the IDE in a different folder. Click Next to continue.

10. Select the Sun ONE Studio 4 components you want to install, and click Next.

    The following components are available:
    - Core Platform and Modules are required (indicated by a green check mark)
    - PointBase Server 4.2 Restricted Edition (deselect by unchecking the box)
Java 2 Platform, Enterprise Edition (J2EE) Reference Implementation 1.3.1  
(deselect by unchecking the box)

**Note** – The best option is to install the J2EE Reference Implementation with the IDE. This software product is provided to enable you to quickly develop a simple J2EE application, as described in Chapter 5.

11. **Decide whether you want to associate** `.java` and `.nbm` **files with the Sun ONE Studio 4 IDE. Click Next to continue.**  
If you decide to associate these file types, the IDE automatically starts when you open these files.

12. **Review the installation summary pane that displays the directory location of the IDE, the features you have selected, and the total size of the installation. Click Next.**

13. **When the installation is complete, click Finish to exit the installation wizard.**

14. **Review the release notes file for important information regarding the release. You can access the release notes from either of these locations:**  
- The product CD’s `image\Documentation\relnote41.html` file  

15. **Continue to Chapter 4 for information on setting up the Sun ONE Studio 4 IDE.**

## Installation in the Linux Environment

You can install the IDE in a supported Linux environment by using the Sun ONE Studio 4 update 1 product CD or by electronically downloading a `.bin` file from the product download web page.

**Note** – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed on your system before installing the Sun ONE Studio 4 IDE. The recommended option is the J2SE, v. 1.4.0_02 platform with the Sun ONE Studio 4 IDE. Read Chapter 2 for instructions on installing the software.

1. **Start the installation.**  
   - If you are installing the software from the Sun ONE Studio 4 update 1 product CD, insert the CD. The Product Selection pane appears.
     a. **Answer yes if you are prompted about whether you want to use Autorun to install the CD.**
b. Write down the serial number provided in the Sun ONE Studio 4 product package.

c. Continue with Step 2.  
   ■ If you are performing a web installation and have not already done these tasks, you must:


b. Save the file into the `s1studio-download-directory`.

c. Write down the serial number provided to you on the download page.

d. Set the `DISPLAY` environment variable to display to your local system.

   If you are installing to your local system, set the `DISPLAY` environment variable to :0.0. If you are using a superuser (root) account or are doing a remote installation, set your superuser session’s `DISPLAY` environment variable to display to your local system.

   For example, to set the variable from a root account running a C shell, type the following in your superuser session command prompt:

   ```
   # setenv DISPLAY your-local-system:0.0
   ```

   e. Set the execute permission on the `ffj_ee_linux_en.bin` file, and execute the file by typing the following:

   ```
   $ cd s1studio-download-directory
   $ chmod a+x ffj_ee_linux_en.bin
   $ ffj_ee_linux_en.bin
   ```

   **Note** – If you encounter errors at any point during the Sun ONE Studio 4 IDE installation, refer to Chapter 10 for some troubleshooting hints.

   f. Skip to Step 4.

2. When the Product Selection wizard appears, select Sun ONE Studio 4 update 1, Enterprise Edition for Java.

   A description of this edition of the IDE appears under the list of products.

3. Click Install.
Note – During the installation process, the installation wizard displays a blue Sun ONE Studio pane with text that states “Launching and Running Installer.” Other installation panes appear in the foreground. Do not close either pane. If you bring the larger blue pane to the foreground, it might hide the secondary installation pane. Keep both panes visible, with the larger blue pane behind the smaller pane.

4. When the InstallShield wizard’s welcome screen appears, click Next to continue. The license agreement pane appears.

5. Read the license agreement carefully. To proceed, accept the terms of the license agreement, and click Next.

You must agree to the license to continue with the installation.

The installer attempts to locate a compatible Java 2 SDK v. 1.3.1 or v. 1.4.0 on your system.

6. Set the location of compatible Java 2 SDK software and click Next.

The IDE requires local or network access to either v. 1.3.1 software or v. 1.4.0 of the Java 2 SDK software. Specify which installed software to use.

Note – The installation directory name cannot contain any spaces, and it must be an empty or new directory.

7. Select the Sun ONE Studio 4 components you want to install.

The following components are available:

- Core Platform and Modules are required (indicated by a green check mark)
- PointBase Server 4.2 Restricted Edition is required (indicated by a green check mark)
- Java 2 Platform, Enterprise Edition (J2EE) Reference Implementation 1.3.1

Note – The best option is to install the J2EE Reference Implementation with the IDE. This software product is provided to enable you to develop a simple J2EE application quickly, as described in Chapter 5.

8. Confirm your installation choice in the installation summary pane, and click Next. The installation wizard installs the Sun ONE Studio 4 components you selected.

9. Review the installation summary pane that displays the directory location of the IDE, the features you have selected, and the total size of the installation. Click Next.

10. When the installation is complete, click Finish to exit the installation wizard.
11. Review the release notes file for important information regarding the release. You can access the release notes from either of these locations:
   - The product CD’s image\Documentation\relnote41.html file

12. Continue to Chapter 4 for information on setting up the Sun ONE Studio 4 IDE.

Installation in the Solaris Operating Environments

You can install the IDE in a supported Solaris operating environment by using the product CD or by downloading a .bin file from the product web page.

**Note** – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed on your system before installing the Sun ONE Studio 4 IDE. The recommended option is the J2SE, v. 1.4.0_02 platform with the Sun ONE Studio 4 IDE. Read Chapter 2 for instructions on installing the software.

1. Start the installation.
   - If you are installing software from the Sun ONE Studio 4 update 1 product CD, insert the CD. (If you are running the Solaris 7 operating environment and you insert the product CD, a message appears stating that the product is not supported on Solaris 7 operating environment.)
     
     a. If you are prompted to use Auto run, answer yes. The Product Selection pane appears.
     
     If Auto run has been disabled on your system, the File Manager appears.
     
     i. Locate the volstart installer file on the CD.
     
     ii. Execute the volstart file.

   b. Write down the serial number provided to you in the Sun ONE Studio 4 product package, if you are using the product CD.

   c. Continue with Step 2.

     - If you are performing a web installation:

     a. Download the ffj_ee_solsparc_en.bin installer file from

     b. Save the file into the s1studio-download-directory.

     c. Write down the serial number provided to you on the download page.
d. Set the **DISPLAY** environment variable to display to your local system.

If you are installing to your local system, set the **DISPLAY** environment variable to :0.0. If you are using a superuser (root) account or are doing a remote installation, set your superuser session’s **DISPLAY** environment variable to display to your local system.

For example, to set the variable from a root account running a C shell, type the following in your superuser session command prompt:

```
# setenv DISPLAY your-local-system:0.0
```

e. Set the execute permission on the `ffj_ee_solsparc_en.bin` file and execute it by double-clicking the file or by typing the following:

```
$ cd s1studio-download-directory
$ chmod a+x ffj_ee_solsparc_en.bin
$ ffj_ee_solsparc_en.bin
```

**Note** – If you encounter errors at any point during the Sun ONE Studio 4 IDE installation, refer to Chapter 10 for some troubleshooting hints.

f. Skip to Step 4.

2. From the Product Selection pane, select Sun ONE Studio 4 update 1, Enterprise Edition for Java.

A description of this edition of the IDE appears under the list of products.

3. Click Install.

**Note** – During the installation process, the installation wizard displays a blue Sun ONE Studio pane with text that states “Launching and Running Installer.” Other installation panes appear in the foreground. Do not close either pane. If you bring the larger blue pane to the foreground, it might hide the secondary installation pane. Keep both panes visible, with the larger blue pane behind the smaller pane.

4. When the InstallShield wizard’s welcome screen appears, click Next to continue.

The license agreement pane appears.
5. Read the license agreement carefully. To proceed, accept the terms of the license agreement, and click Next to continue.

You must agree to the license to continue with the installation.

The installer attempts to locate a compatible Java 2 SDK v. 1.3.1 or v. 1.4.0 on your system.

6. Set the location of compatible Java 2 SDK software, and click Next.

The IDE requires local or network access to either v. 1.3.1 or v. 1.4.0 of the Java 2 SDK software. Specify which installed Java 2 SDK software to use.

7. Specify a serial number by doing one of the following, and click Next to continue with the installation.

- If you have been provided with one in the Sun ONE Studio 4 product CD or as part of the electronic download process, type it in the designated text field.

- Click 60 day trial to generate a serial number that expires in 60 days. Write down the trial serial number that appears.

The trial serial number gives you access to the Update Center services once you have registered the product. Read Chapter 4 for product registration information and “Updating Modules With the Update Center” on page 87 for information on the Sun ONE Studio Update Center.

8. Accept the default installation folder, or click Browse to install the IDE in a different directory. Click Next to continue.

Note – The installation directory name cannot contain any spaces, and it must be an empty or new directory.

9. Select the Sun ONE Studio 4 components you want to install.

The following components are available:

- Core Platform and Modules (required, as indicated by a green check mark)
- PointBase Server 4.2 Restricted Edition
- Java 2 Platform, Enterprise Edition (J2EE) Reference Implementation 1.3.1
- Solaris Developer Modules (required, as indicated by a green check mark)

a. If you select Solaris Developer Modules while performing a standalone install, such as the product web download, the FCC linking pane appears.

b. When prompted for a path to the FCC software, enter the full path to the Sun ONE Studio 7 Compiler Collection (formerly Forte Developer 7) in the provided text field.
10. Review the installation summary pane that displays the directory location of the IDE, the features you have selected, and the total size of the installation. Click Next.

11. When the installation is complete, click Finish to exit the installation wizard.

12. Review the release notes file for important information regarding the release. You can access the release notes from either of these locations:
   - The product CD’s image\Documentation\relnote41.html file

13. Continue to Chapter 4 for information on setting up the Sun ONE Studio 4 IDE.

---

**Installing the IDE With the Command-Line Options**

If you prefer to install the Sun ONE Studio 4 IDE using the command line, follow these steps. You need to create a file called `installer.sp` and add to the file the command-line options you want to use to install the IDE.

1. If you have not already done so, download the installer file for your supported platform from http://www.sun.com/software/sundev/jde/buy/index.html or locate the file (in the image/ffj_installers_ee directory) on the Sun ONE Studio 4 update 1 product CD.
   a. Save the installer file into the `s1studio-download-directory`.
      On Microsoft Windows systems, download the `ffj_ee_win32_en.exe` file. In a Solaris environment, download the `ffj_ee_solsparc_en.bin` file. In a Linux environment, download the `ffj_ee_linux_en.bin` file.
   b. Write down the serial number provided to you on the download page or locate the serial number in the Sun ONE Studio 4 product package, if you are using the product CD.
   c. If you decide to type the installation options directly on the command line, you do not need the `installer.sp` file. Skip to Step 3.
2. Create an `installer.sp` file in the `s1studio-download-directory`.

   The IDE installer reads the command-line options you include in the `installer.sp` file.

   On a Microsoft Windows system, create a file called `ffj_ee_win32_en.sp` and place the file in the `s1studio-download-directory`.

   For the Solaris and Linux environments, name the file `ffj_ee_solsparc_en.sp` and `ffj_ee_linux_en.sp`, respectively and place the file in the `s1studio-download-directory`. 
3. Determine the command-line options and corresponding values you want to use, and include them in the installer . sp file.

TABLE 3-1 lists the different command-line options and their default values, if any. You can use either the long or short name for each option.

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>forthehome=s1studio-install-directory</td>
<td>Specifies the directory into which you want the IDE installed. This is a mandatory command-line parameter for the -silent mode.</td>
</tr>
<tr>
<td>fh=s1studio-install-directory</td>
<td></td>
</tr>
<tr>
<td>jdkhome=jdkhome-dir</td>
<td>Sets the location of the valid Java 2 SDK version to use with the IDE. The installer configures the IDE to use this Java 2 SDK software. This is a mandatory command-line parameter for the -silent mode.</td>
</tr>
<tr>
<td>jh=jdkhome-dir</td>
<td></td>
</tr>
<tr>
<td>serialnumber=serial-number</td>
<td>Sets the serial number for the IDE. Use the serial number you received when you downloaded the Sun ONE Studio 4 IDE installer software, or the one included with the Sun ONE Studio 4 product package. You can also specify the value trial to generate a temporary license that will expire after 60 days. This is a mandatory command-line parameter for the -silent mode.</td>
</tr>
<tr>
<td>serialnumber=trial</td>
<td></td>
</tr>
<tr>
<td>sn=serial-number</td>
<td></td>
</tr>
<tr>
<td>sn=trial</td>
<td></td>
</tr>
<tr>
<td>pointbaseinstall=yes</td>
<td>Specifies whether to install the PointBase Server 4.2 Restricted Edition. The default value is yes.</td>
</tr>
<tr>
<td>pointbaseinstall=no</td>
<td></td>
</tr>
<tr>
<td>pi=yes</td>
<td></td>
</tr>
<tr>
<td>pi=no</td>
<td></td>
</tr>
<tr>
<td>j2eeinstall=yes</td>
<td>Specifies whether to install the J2EE Reference Implementation 1.3.1. The default value is yes.</td>
</tr>
<tr>
<td>j2eeinstall=no</td>
<td></td>
</tr>
<tr>
<td>ji=yes</td>
<td></td>
</tr>
<tr>
<td>ji=no</td>
<td></td>
</tr>
<tr>
<td>fccHome=FCC_path</td>
<td>(Solaris only) Sets the path to the directory where the Sun ONE Studio 7 is installed. This option is valid only in a supported Solaris environment.</td>
</tr>
<tr>
<td>fch=FCC_path</td>
<td></td>
</tr>
<tr>
<td>si=yes</td>
<td>(Solaris only) Specifies whether to install the Solaris Developer Modules. The default value is yes. This option is valid only in supported Solaris environments.</td>
</tr>
<tr>
<td>si=no</td>
<td></td>
</tr>
<tr>
<td>soldevInstall=yes</td>
<td></td>
</tr>
<tr>
<td>soldevInstall=no</td>
<td></td>
</tr>
<tr>
<td>-silent</td>
<td>This option is specified on the command line and not in the installer . sp file. If not specified, the InstallShield wizard appears. If specified, any error messages will be displayed on the command window from which the installer was invoked.</td>
</tr>
</tbody>
</table>

For example, on a Microsoft Windows system, the ffj_ee_win32_en.sp file might
have the following contents:

```
fh=C:\forte4j
jh=C:\j2sdk1.4.0_02
sn=trial
pi=yes
ji=yes
```

In a Solaris environment, the `ffj_ee_solsparc_en.sp` file might have the following contents:

```
fh=/yourserver/forte4j
jh=/usr/j2se
sn=trial
pi=yes
ji=yes
si=yes
fch=/yourserver/fcc
```

4. **Invoke the installer from the command line.**

For example, on a Microsoft Windows system, type the following in a command prompt window:

```
C:\>cd s1studio-download-directory
C:\s1studio-download-directory> ffj_ee_win32_en.exe -silent
```

For example, in a Solaris environment, type the following in a terminal window:

```
$ cd s1studio-download-directory
$ ffj_ee_solsparc_en.bin -silent
```

The installer uses the options you have specified in the `installer.sp` file for your system and displays the following in the command prompt window:

```
InstallShield Wizard

Initializing InstallShield Wizard...

Searching for Java(tm) Virtual Machine...
...........
Running InstallShield Wizard...
```
If you chose to use the `ffj_ee_en.jar` file, type your installation options when you execute the `ffj_ee_en.jar` file.

For example, on a Microsoft Windows system, type the following in a command prompt window:

```
C:\java -Dfh=C:\forte4j -Djh=C:\j2sdk1.4.0_02 -Dpi=yes -jar ffj_ee_en.jar
```

Similarly, in a Solaris or Linux environment, type the following in a command prompt window, for example:

```
$ java -Dfh=/yourserver/forte4j -Djh=/usr/j2se -Dpi=yes -jar ffj_ee_en.jar
```

Any error messages are displayed in the command prompt or terminal window.

**Note** – If you encounter errors at any point during the Sun ONE Studio 4 IDE installation, refer to Chapter 10 for some troubleshooting hints.

5. Continue to Chapter 4 for information on setting up the Sun ONE Studio 4 IDE.

### Finding Installation Subdirectories

After you have installed the Sun ONE Studio 4 IDE, the subdirectories listed in TABLE 3-2 can be found under `s1studio-install-directory`, your Sun ONE Studio 4 installation directory.

<table>
<thead>
<tr>
<th>Subdirectory Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LICENSE.html</td>
<td>Contains the Sun Microsystems, Inc., binary code license agreement.</td>
</tr>
<tr>
<td>/_uninst</td>
<td>Contains the files used to uninstall the IDE.</td>
</tr>
<tr>
<td>/beans</td>
<td>Contains JavaBeans™ components installed in the IDE.</td>
</tr>
<tr>
<td>Subdirectory Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>/bin</td>
<td>Includes the Sun ONE Studio 4 startup scripts (as well as the ide.cfg file in Microsoft Windows installations). (Solaris only) Also contains launch points for the standalone applications delivered with the Solaris tools, including xemacs, gvim, xdesigner, and forte_fcc.</td>
</tr>
<tr>
<td>/docs</td>
<td>Contains the Sun ONE Studio 4 help files and other miscellaneous documentation.</td>
</tr>
<tr>
<td>/emacs (Solaris only)</td>
<td>Contains emacs files.</td>
</tr>
<tr>
<td>/examples</td>
<td>Contains source files for examples that illustrate several key features of the Sun ONE Studio 4, Enterprise Edition for Java.</td>
</tr>
<tr>
<td>/j2sdkeel.3.1</td>
<td>Contains the J2EE Reference Implementation v. 1.3.1 files, if you chose to install those files during the Sun ONE Studio 4 installation process.</td>
</tr>
<tr>
<td>/jwsdp</td>
<td>Contains files and directories specific to the Java Web Services Developer Pack.</td>
</tr>
<tr>
<td>/lib</td>
<td>Contains the JAR files that make up the IDE’s core implementation and the open APIs.</td>
</tr>
<tr>
<td>/man (Solaris only)</td>
<td>Contains man pages for Solaris Developer Modules, if installed.</td>
</tr>
<tr>
<td>/modules</td>
<td>Stores Sun ONE Studio 4 modules as JAR files.</td>
</tr>
<tr>
<td>/platform (Solaris only)</td>
<td>Contains platform-specific files.</td>
</tr>
<tr>
<td>/pointbase</td>
<td>Contains four subdirectories, client, databases, docs, and server. The client directory contains the PointBase console, command-line utilities, and examples of a PointBase application. The databases directory contains a sample database. The docs directory contains PointBase documentation. The server directory contains the PointBase server.</td>
</tr>
<tr>
<td>/sources</td>
<td>Contains sources for libraries that might be redistributed with user applications.</td>
</tr>
<tr>
<td>/system</td>
<td>Includes files and directories used by the IDE for special purposes. Go to your individual fff-user-dir/system directory to get the ide.log, which provides information useful when requesting technical support, and to view project.basic and project.last files, which contain information on Sun ONE Studio 4 projects. On a Microsoft Windows system, this fff-user-dir/system directory contains the project-specific files under project.basic_hidden and project.last files.</td>
</tr>
<tr>
<td>/tomcat401</td>
<td>Contains Tomcat-specific files.</td>
</tr>
<tr>
<td>update_tracking.xml</td>
<td>Contains information used by the Update Center.</td>
</tr>
</tbody>
</table>
Uninstalling the Sun ONE Studio 4 IDE

An uninstaller wizard is available to assist you in the uninstallation of the Sun ONE Studio 4 IDE. Follow these steps to uninstall your copy of the Sun ONE Studio 4 IDE:

1. **Start the uninstaller from the** `s1studio-install-directory/ee_uninst directory`.  
   - On a Microsoft Windows system, execute the `uninstaller.exe` file located in the `s1studio-install-directory/_uninst` directory or use the Add/Remove Program utility in the Control Panel.
   - In a supported Solaris or Linux environment, ensure that your `DISPLAY` environment variable is defined correctly, and then type:

```
$ java -jar uninstall.jar
```

The uninstaller’s Welcome screen appears.

2. **Click Next from the Welcome screen.**  
   A list of Sun ONE Studio 4 components is displayed.

3. **Select the components you want to uninstall and click Next.**

4. **Click Next to confirm the components to be uninstalled.**  
   The uninstaller wizard proceeds with the uninstallation of the IDE.

5. **Click Finish to close the uninstaller wizard.**
Using Your Newly Installed Sun ONE Studio 4 IDE

After you have successfully installed the Sun ONE Studio 4 IDE, use the information in this chapter to start, set up, and register your IDE. Details about the available command-line switch options are also included.

Setting Up Your Sun ONE Studio 4 IDE

When you first start up the IDE, you are prompted to:

- Register your software
- Specify the user directory to use with the IDE
- Indicate whether you would like automatic update checking

Use the following steps to guide you through setup of your initial IDE environment:

1. **Start the Sun ONE Studio 4 IDE.**
   - For a Microsoft Windows system, you:
     a. Double-click the Sun ONE Studio 4 EE icon created on your desktop or click the Start menu.
     b. Choose Programs → Sun Microsystems → Sun ONE Studio 4 EE → Sun ONE Studio.
       - Alternatively, from a command prompt window, type:

```
C:\>cd s1studio-install-directory\bin
C:\s1studio-install-directory\bin>runidew.exe
```

If this is the first time you are installing this version of the IDE on a Microsoft Windows system, you are prompted for the user directory.
For the supported Solaris or Linux environments, type:

```
$ cd s1studio-install-directory/bin
$ runide.sh
```

Skip to Step 3.

2. *(Microsoft Windows only)* Type the name of the directory where you want the IDE to store your settings and project information, and click OK.

Ensure that the directory you create is in a place that is always accessible to your system. If you have different versions of the IDE, use a different user directory for each IDE version. This directory should be different from the directory where the IDE is installed.

The Settings Import wizard appears.

3. In the Settings Import wizard, specify whether you want to import your settings from a previous version of the IDE.

   - If you do not want to import your previous user settings, select No and click Finish to exit the wizard.
     
     On a Microsoft Windows system, the user directory is created in the previous step or set to the same user directory you specified in a previous installation of this version of the IDE if you did not remove the previous UserDir value in the registry.
     
     For supported Solaris or Linux environments, the default user directory is created and named `$HOME/ffjuser40ee`.

   - If you want to import your previous user settings, select Yes and click Next.
     
     You are prompted for the location of the user directory for the previously installed IDE.
     
     a. Specify the path or click Browse to locate the directory. Click Next.
     
        The IDE imports the settings.

     b. Click Finish to exit the wizard.
     
        The IDE continues with the startup, and the Setup wizard appears.

4. If you are behind a firewall, specify the proxy server information.

5. Select the window mode, and click Next to continue with the setup.

6. Click Finish to continue with IDE startup, or click Next for additional setup options.

   - If you click Finish, the IDE continues with the startup and several windows appear. The registration wizard appears. Continue with Step 11.
7. (Solaris only) In the Text Editor Preference pane, select the text editor you want to use with the IDE. Click Next to continue with the setup, or Finish to continue with the IDE startup.

The installation of the Solaris Developer Modules includes the XEmacs and VIM text editors. You can select from the IDE’s built-in editor, XEmacs, or VIM as the default text editor to use with the IDE. If you decide to modify the default text editor at a later time, choose Tools → Setup Wizard from the main window of the IDE.

If you click Finish, the IDE continues with the startup and several windows appear. The registration wizard appears. Continue with Step 11.

If you click Next, the Module Installation pane appears.

8. In the Module Installation pane, specify which module you want to enable or disable.

By default, all the modules installed with the IDE are enabled. Disable a module by doing the following:

a. Click the Enabled property value for the module.

b. Click a second time and select False to disable the module.

9. Click Next to continue with the setup, or click Finish to continue with the IDE startup.

If you click Finish, the IDE continues with the startup and several windows appear. The registration wizard appears. Continue with Step 11.

If you click Next, the Update Center pane appears.

10. From the Update Center pane, specify how often you want the IDE to automatically check the Update Center. Select the Sun ONE Studio Update Center as the center from which you want to obtain the updates for modules of your choice. Click Finish.

11. From the registration wizard, select your preferred method of registration.

Select “Register using the web” to register your Sun ONE Studio 4 software using the web, or to edit your existing registration information if you have changed Sun ONE Studio 4 editions.

The registration page appears in your web browser. You can register the product, create a new Sun ONE Studio 4 Developer Resources account, or update your account.

Registering your Sun ONE Studio 4 software through the web enables you to:

- Use the Update Center to download and install new modules and updates specific to your environment
- Subscribe to the Early Access Program (http://forte.sun.com/eap) and receive new, nonpublic builds of the IDE, as well as preview releases of Sun ONE Studio 4 modules, patches, and bug fixes
- Receive product announcements, if desired
- Use the same user name and password to access the Update Center, the Early Access Program, and the Sun Download Center (from which you might have downloaded the Sun ONE Studio 4 IDE)

If you are already registered with Sun ONE Studio Developer Resources, Sun Download Center, or mysun.sun.com, you can use the same user name and password, but you are prompted for additional information.

---

**Note** – To maintain your Sun ONE Studio Developer Resources account using the web, choose Help → Registration Wizard from the main window of the IDE. Or, go to http://forte.sun.com/services/registration/accountmaintenance.html.

---

- Register by FAX or mail.

  This method of registration registers only your Sun ONE Studio 4 IDE.

  If you decide to register with Sun ONE Studio Developer Resources at a later time, choose Help → Registration Wizard from the main window of the IDE.

12. **From the Automatic Update Check dialog box, specify whether you want to check for new IDE updates.**

   - If you reply Yes, the Update Center wizard appears. Follow the wizard’s instructions to complete the setup for automatic update checking.
   - If you reply No, you can start the Update Center wizard at a later time by choosing Tools → Update Center from the main window of the IDE.

13. **Continue to Chapter 5 for instructions on validating your installation of the IDE.**

---

### Using the Startup Command-Line Options

The IDE startup scripts for all supported platforms can be run with additional options. These command-line options are specified with flags. In this document, these flags are referred to by the variable `[s1studio-ide-options]` when used on the command line.
On a Microsoft Windows system, for example, you might type:

```
C:\>runidew.exe -help
```

In a Linux or Solaris environment, for example, you might type:

```
# runide.sh -help
```

Alternatively, you can put the options in the `s1studio-install-directory/bin/ide.cfg` file. The IDE reads this file before parsing any command-line options. You can break options into multiple lines in `ide.cfg`.

TABLE 4-1 lists the startup command-line options for all supported platforms.

### TABLE 4-1 Command-Line Switch Options

<table>
<thead>
<tr>
<th>Switch Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-h</code></td>
<td>Prints usage.</td>
</tr>
<tr>
<td><code>-help</code></td>
<td></td>
</tr>
<tr>
<td><code>-jdkhome jdk-home-dir</code></td>
<td>Selects an SDK other than the default SDK. On Microsoft Window systems, by default, the IDE checks the registry and selects the latest SDK available.</td>
</tr>
<tr>
<td><code>-hotspot or -server or -client or -classic or -native or -green</code></td>
<td>Explicitly specifies the Java virtual machine (JVM™) variant to be used. The terms “Java virtual machine” and “JVM” mean a virtual machine for the Java platform.</td>
</tr>
<tr>
<td><code>-cp:p additional-classpath</code></td>
<td>Prepends the specified class path onto the IDE's class path.</td>
</tr>
<tr>
<td><code>-cp:a additional-classpath</code></td>
<td>Appends the specified class path to the IDE's class path.</td>
</tr>
<tr>
<td><code>-ui UI_class-name</code></td>
<td>Selects a given class as the IDE's look and feel.</td>
</tr>
<tr>
<td><code>-fontsize size</code></td>
<td>Sets the font size, expressed in points, in the IDE's user interface.</td>
</tr>
<tr>
<td><code>-single</code></td>
<td>Starts the IDE from <code>s1studio-install-directory</code> instead of from your <code>s1studio-user-directory</code> directory. Runs the Sun ONE Studio 4 IDE in single-user mode. The default mode is multiuser.</td>
</tr>
</tbody>
</table>
In the Solaris and Linux environments, users can modify startup scripts to suit their needs.

<table>
<thead>
<tr>
<th>Switch Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-fortecc fcc-path</td>
<td>(Solaris only) Specifies the path to the Forte Compiler Collection to use for this session of the IDE. Overrides any default settings created in the IDE or user directory.</td>
</tr>
<tr>
<td>-userdir s1studio-user-directory</td>
<td>Explicitly specifies the s1studio-user-directory (the location where your user settings are stored). If this option is not used on a Microsoft Windows system, the user is prompted at the initial startup of the IDE for the s1studio-user-directory directory to use. On Microsoft Windows systems, this value is stored in the registry for later use. If this option is not used in Solaris or Linux operating environments, the location is user-home-dir/ffjuser40ee.</td>
</tr>
<tr>
<td>-J jvm-flags</td>
<td>Passes specified flags directly to the JVM.</td>
</tr>
<tr>
<td>-J-Xverify:none</td>
<td>Tells the JVM not to verify the correctness of the bytecode for faster startup. Bytecode verification is a slow process. Whenever a class is loaded, the JVM scans all bytecode and detects an invalid byte sequence even if a method is never called. Also, the JVM loads certain classes referred to in method signatures and in the method body, even though they are not called during startup. However, setting this flag removes some of the protection that the Java language gives you. (Refer to the JVM documentation for more information.)</td>
</tr>
<tr>
<td>-J-Xms24m</td>
<td>Sets up the initial heap size of the JVM to 24 MB. This switch prevents the JVM from extending the heap size during startup, which enables faster startup time for the IDE.</td>
</tr>
</tbody>
</table>

In the Solaris and Linux environments, users can modify startup scripts to suit their needs.
Validating Your Sun ONE Studio 4 Installation

This chapter contains information on how to validate your installation of the Sun ONE Studio 4, Enterprise Edition for Java. Instructions are provided to help you through the creation of a simple HelloWorld web application using the J2EE Reference Implementation 1.3.1.

Note – The following instructions assume you have already installed the J2EE Reference Implementation 1.3.1 during the IDE installation.

Starting the Default J2EE Reference Implementation Instance

The J2EE Reference Implementation server is configured automatically when you install the J2EE Reference Implementation 1.3.1 during the Sun ONE Studio 4 IDE installation. An instance of the J2EE Reference Implementation is added to the IDE’s server registry. This instance is also set to be the default application server after the IDE installation.

If the J2EE Reference Implementation 1.3.1 is not active when you deploy or execute an application, it automatically starts.

The following instructions explain how to start and verify the default J2EE Reference Implementation server instance:

1. Start the Sun ONE Studio 4 IDE.
On Microsoft Windows systems, choose Programs → Sun Microsystems → Sun ONE Studio 4 EE → Sun ONE Studio from the Start menu, or start a command window and type the following:

```
C:\>cd s1studio-install-directory\bin
C:\s1studio-install-directory\bin>runidew.exe
```

In Solaris or Linux environments, type the following command at the command line:

```
$ cd s1studio-install-directory/bin
$ runide.sh [s1studio-ide-options]
```

**Note** – See “Using the Startup Command-Line Options” on page 58 for more information on `s1studio-ide-options`.

2. **Verify that the RI Home property is set correctly.**
   
a. In the Explorer window of the IDE, click the Runtime tab and expand the nodes for Server Registry and Installed Servers.
   
b. Right-click J2EE Reference Implementation 1.3.1 and choose Properties from the contextual menu. (Alternately, you can select the J2EE Reference Implementation 1.3.1 node and look below the Explorer at the Stationary Property window.)
   
The property sheet for J2EE Reference Implementation appears.
   
c. **Verify that the RI Home property already has a value of**

   `s1studio-user-directory/j2sdkee1.3.1`.

   If it does not, set the value by selecting the RI Home property and typing the correct value. If you must manually enter a value, be sure you have write access to the RI installation directory that you enter.

3. **Start the J2EE Reference Implementation 1.3.1 instance.**
   
a. Expand the Server Registry and Installed Server nodes from the Runtime tab of the Explorer window.

   All the application servers that have already been installed are listed under the Installed Servers node.
   
b. **Expand the J2EE Reference Implementation 1.3.1 node.**

   You can see the RI instances that have already been added to the Server Registry.
c. Right-click RI Instance 1 and choose Start Server from the contextual menu. The corresponding messages appear in the Output window. For example, in a Microsoft Windows system, you see the following:

```
J2EE server listen Port: = 1050
Redirecting the output and error streams to the following files:
s1studio-user-directory\j2sdkee1.3.1\logs\myhost\j2ee\j2ee\system.out
s1studio-user-directory\j2sdkee1.3.1\logs\myhost\j2ee\j2ee\system.err
J2EE server startup complete.
```

4. Verify the server instance status in a web browser using http://localhost:8000 for the URL. If you have correctly integrated your server, you see the J2EE 1.3.1 Default Home Page.

---

**Note** — If you receive an error message when verifying the server instance status, refer to Chapter 10 for some troubleshooting hints. If you need to modify the default port settings assigned to the J2EE Reference Implementation 1.3.1, e.g. in a multiuser environment, refer to Appendix B for information.

---

### Creating a HelloWorld J2EE Application

The following steps guide you in creating a simple test application using the J2EE Reference Implementation 1.3.1 that was installed with the IDE.

**Note** — The following instructions assume you have already started the default J2EE Reference Implementation instance. See “Starting the Default J2EE Reference Implementation Instance” on page 61 for more information.

1. Create a new directory called verificationApp.
2. Start the Sun ONE Studio 4 IDE, if you have not already done so.
On Microsoft Windows systems, choose Programs → Sun Microsystems → Sun ONE Studio 4 EE → Sun ONE Studio from the Start menu, or start a command window and type the following:

```
C:\>cd s1studio-install-directory\bin
C:\s1studio-install-directory\bin>runidew.exe
```

In a Solaris or Linux environment, type the following command at the command line:

```
$ cd s1studio-install-directory/bin
$ runide.sh [s1studio-ide-options]
```

Note – See “Using the Startup Command-Line Options” on page 58 for more information on s1studio-ide-options.

3. Mount the new verificationApp directory in the IDE by choosing File → Mount Filesystems from the main window of the IDE.

   The New wizard appears.

   a. Select Local Directory and click Next.

   b. Select the newly created directory, verificationApp, and click Finish.

   A new node for verificationApp appears on the Filesystems tabbed pane of the Explorer window.

4. In the Filesystems tabbed pane of the Explorer window, create a new Java package named hello by right-clicking the verificationApp node and choosing New → Java package.

   The New wizard for a Java package appears.

5. In the New wizard, type the name hello for the new Java package and click Finish.

   A new node for the hello package appears on the Filesystems tabbed pane of the Explorer window.

6. In the Explorer window, right-click the hello node and choose New → J2EE → Session EJB to create a new session bean named helloTest.

   The New wizard for a session bean appears.
7. Specify the bean name as `helloTest`, use all the default settings on the New wizard, and click Finish.

The new `helloTest(EJB)` node appears in the Filesystems tabbed pane of the Explorer window. Nodes for `helloTest`, `helloTestBean`, and `helloTestHome` also appear.

8. Add a business method by right-clicking the `helloTest(EJB)` node and choosing Add Business Method.

The Add New Business Method dialog box appears.

9. In the Add New Business Method dialog box, name the method `sayHello`.
   a. Set the return type by selecting `java.lang.String` from the combo box.
   b. Click OK.

10. Edit the `sayHello` method using the Source Editor.
    a. In the Explorer window, expand the `helloTest(EJB)` node and expand the Business Methods node.
    b. Right-click `sayHello()`, and choose Open.
        The Source Editor opens and displays the contents of the `helloTestBean` method.
    c. In the Source Editor, add one line, so the method looks like this:

    ```java
    public java.lang.String sayHello() {
        return "Hello there, world!";
    }
    ```

11. Choose Build → Compile from the main window of the IDE or press F9 to compile the `sayHello` method.

    If no compilation errors are encountered, the Output window displays the message Finished `helloTestBean`.

12. From the Filesystems tabbed pane of the Explorer window, create a new EJB Test application by right-clicking the `helloTest(EJB)` node and choosing Create New EJB Test Application.

    The Create a New EJB Test Application dialog box appears.

13. Accept all the default values by clicking OK.

    An EJB module called `helloTest_EJBModule`, a web module named `helloTest_WebModule`, and an application named `helloTest_TestApp` are created and automatically mounted in the IDE.
14. In the Filesystems tab of the Explorer window, right-click the helloTest_TestApp node and choose Execute.

A progress monitor is displayed and the IDE switches to the Running tab. The helloTest_TestApp is deployed and your web browser appears with the URL displayed as http://localhost:8000/helloTest_TestApp/dispatch.jsp.

If the browser is not displayed automatically, open it manually and type http://localhost:8000/helloTest_TestApp for the URL.

**Note** – Ensure that your web browser is configured to not use proxy servers for domains beginning with localhost.

If the http://localhost:8000/helloTest_TestApp/dispatch.jsp page is displayed, the J2EE Reference Implementation server is working correctly.

You have now verified that your installation of the IDE and the J2EE Reference Implementation is working properly. At this point, you can skip the steps remaining in this chapter or continue to run the session bean’s method.

15. Run the session bean’s method by clicking the Invoke button next to hello.helloTest create in the http://localhost:8000/helloTest_TestApp/dispatch.jsp page in your web browser.

The correct button is the first Invoke button on the page, under Invoke Methods in the hello.helloTestHome section.

a. In the EJB Navigation section of the next page, click hello.helloTest[7].

The number 7 might be some other number in your web browser.

b. Click Invoke next to java.lang.String sayHello.

The Results of the Last Method Invocation section displays the following:

```
Hello there, world!
Method Invoked: sayHello()
Parameters:
none
```

You have completed running the session bean’s method.
Customizing Your Installation

This chapter contains information to assist you in customizing your installation of Sun ONE Studio 4, Enterprise Edition for Java. It includes information about the PointBase Server 4.2 Restricted Edition and the IDE’s internal UDDI Registry server.

Using Databases With the Sun ONE Studio 4 IDE

The PointBase Server 4.2 Restricted Edition is available for installation with the IDE. You can use other databases with the IDE by configuring the JDBC enabled database drivers for those databases.

Note – The following instructions assume you have already installed the PointBase Server 4.2 Restricted Edition during the IDE installation.

Using a PointBase Database

PointBase Server 4.2 Restricted Edition is the default database that is provided with the Sun ONE Studio 4 IDE installation. For information on using this database and database tables, see the PointBase documentation at either s1studio-install-directory/pointbase/server/GettingStarted.html or s1studio-install-directory/pointbase/client/GettingStarted.html.
Starting the PointBase Database Server

You have to start the PointBase database server before you can use it, whether you want to access a PointBase database from an application you developed using the IDE or you want to create your own tables or database with PointBase software.

To start the PointBase database server:

- Choose Tools → PointBase Network Server → Start Server from the main window of the IDE.

The PointBase 4.2 window appears.

Stopping the PointBase Database Server

To stop the PointBase database server:

- Choose Tools → PointBase Network Server → Stop Server from the main window of the IDE or choose Server → Shutdown! from the PointBase 4.2 window.

Starting the PointBase Client Console

To start a PointBase console, do the following:

- On Microsoft Windows systems, start the PointBase client console by choosing Programs → Sun Microsystems → Sun ONE Studio 4 EE → PointBase → Console from the Start menu or double-click the console.bat file in the s1studio-install-directory/pointbase/client directory.

A “Connect to Database” dialog box appears. Click OK to continue.

- In a Solaris or Linux environment, type:

  $ sh s1studio-install-directory/pointbase/client/Console

Stopping the PointBase Client Console

- To stop the client console, select File → Exit from the Console menu.
Customizing Your PointBase Database

The J2EE Reference Implementation 1.3.1 is preconfigured to use the PointBase Server 4.2 Restricted Edition server included with the IDE. Starting the J2EE Reference Implementation 1.3.1 server does not start the PointBase server. You must start the PointBase Server 4.2 Restricted Edition server separately, as previously instructed in this chapter.

The J2EE Reference Implementation 1.3.1 is configured to use the default PointBase database, named “sample.” If you want to create a different PointBase database, you must do the following:

- Change the RI resource properties to point to your new database
- Create the new database in the PointBase console

To configure the J2EE RI resource properties to point to your new database, use the $J2EE_HOME/bin/j2eeadmin tool to update the $J2EE_HOME/config/resource.properties file. The $J2EE_HOME is set to the s1studio-user-directory/j2sdkee1.3.1 directory.

The j2eeadmin syntax to create a different PointBase database is as follows:

```
j2eeadmin -addJdbcDatasource jndi_name url
```

For example, in a Solaris environment, you might type the following at the command line:

```
$ $J2EE_HOME/bin/j2eeadmin -addJdbcDatasource jdbc/DB1
jdbc:pointbase:server://localhost/yourdatabase
```

Alternatively, you can manually edit the $J2EE_HOME/config/resource.properties file and modify the jdbc.resources variable, as follows:

```
jdbc.DataSource.0.url=jdbc:pointbase:server://localhost/your-database
```

To create a new non-default data base, follow these steps:

1. Start the PointBase Server.

   - Choose Tools → PointBase Network Server → Start Server from the main window of the IDE.

   The PointBase 4.2 window appears.
2. Start the PointBase Console.
   - In Solaris or Linux environments: Run the Console file in the $s1studio-install-directory/pointbase/client directory.
   - On Microsoft Windows: Choose Start → Programs → Sun Microsystems → Sun ONE Studio 4 EE → PointBase → Console or double-click the console.bat file in the $s1studio-install-directory/pointbase/client directory.

   The Connect To Database dialog box appears, showing values for the PointBase driver to the default sample database.

3. Change the word sample at the end of the URL field to yourdatabase.

4. Set the Create New Database option and click OK.

   The PointBase Console is displayed. Wait until the status message ending in “Ready” is displayed before proceeding.

Starting the PointBase Server Outside the Sun ONE Studio IDE

On Microsoft Windows 2000 and XP systems, follow these steps.

1. Type the following at a command line prompt:

   ```
cd $s1studio-install-directory\pointbase\server
   ```

2. Then type:

   ```
   netserver.bat “-Dpointbase.ini=$s1studio-user-directory\pointbase\pointbase.ini” /win
   ```

On Microsoft Windows NT and 98 systems, follow these steps.

1. Type the following at a command line prompt:

   ```
cd $s1studio-install-dir\pointbase\server
   ```

2. Then type:

   ```
   netserver.bat “-Dpointbase.ini=$s1studio-install-directory\pointbase\pointbase.ini” /win
   ```
On a Solaris or Linux system, follow these steps.

1. Define the environment variable PB_JAVA_OPTS to be “-Dpointbase.ini=s1studio-user-directory/pointbase/pointbase.ini” For example, type:

   ```
   $ setenv PB_JAVA_OPTS "-Dpointbase.ini=s1studio-user-directory/pointbase/pointbase.ini"
   $ setenv PB_JAVA_OPTS "-Dpointbase.ini=s1studio-user-directory/pointbase/pointbase.ini"
   ```

2. Then go to the PointBase server directory, by typing:

   ```
   $ cd s1studio-install-dir/pointbase/server
   ```

3. Start the server by typing:

   ```
   $ Server /win
   ```

### Using Other JDBC Enabled Databases

The following information applies to database drivers other than the driver for the PointBase Server 4.2 Restricted Edition database.

You must place database driver files in the Sun ONE Studio 4 lib/ext directory before you start the Sun ONE Studio 4 IDE. If you do not do this, the dbschema wizard does not enable you to select the proper database driver when you create a new schema. You cannot mount the driver file in the IDE’s Explorer, nor can you simply place the driver file in the CLASSPATH environment variable. You must copy the driver file into the lib/ext folder.

The same database driver must also be added to the $J2EE_HOME/lib/system directory so that the application server is aware of the new database driver. Read the information contained in s1studio-install-directory/j2sdkee1.3.1/doc/release/ConfigGuide.html#12442 for more information on required steps for adding more database drivers to the J2EE Reference Implementation 1.3.1 application server.
Configuring your IDE for Web Service Development

This section provides information about configuring your IDE for web service development. An RMI (remote method invocation) message box appears when you are deploying a web service for the first time. Web services do not require RMI enabling. If the message box appears, press No To All to automatically set the Detect Remote option to false.

To avoid getting this message, disable the RMI check on newly created files.

1. In the RMI module configuration pane, select Tools, then Options, then Distributed Application Support, and finally RMI Settings.

2. Set the Detect Remote option to false.

Using the IDE’s Internal UDDI Registry Server

A single-user, internal UDDI registry is bundled with the IDE as a convenience for end-to-end testing of your development process. This registry runs in a dedicated Tomcat server, which the IDE starts and stops automatically when you start and stop the registry server.

Note – The internal UDDI registry is configured with a single user. The name is testuser and the password is testuser. Set this name and password as the default for the internal registry.

To start the internal UDDI registry server:

1. Expand the UDDI Server Registry node in the Explorer’s Runtime tabbed pane.

2. Right-click the Internal UDDI Registry node and choose Start Server.

   The IDE’s Output window displays server startup messages. You might also see messages stating that the IDE is stopping a previous Tomcat server process.
Note – If the internal UDDI registry server is already running, the Start Server menu item is inactive.

To stop the internal UDDI registry server:

1. Expand the UDDI Server Registry node in the Explorer’s Runtime tabbed pane.
2. Right-click the Internal UDDI Registry node and choose Stop Server.
   Server stop messages are displayed.

Note – If the internal UDDI registry server is not running, the Stop Server menu item is inactive.
Using the Sun ONE Application Server 7 With the Sun ONE Studio 4 IDE

Once you have successfully installed the IDE and validated the installation by creating a simple J2EE application (as described in Chapter 5), you can connect the IDE to the Sun ONE Application Server 7. Once connected, you can use the Sun ONE Application Server 7 to deploy applications that you create with the IDE.

System Requirements

You can use the Sun ONE Application Server 7 from the following platforms:

- Solaris 8 operating environment (32-bit or 64-bit SPARC platforms)
- Solaris 9 operating environment (32-bit or 64-bit SPARC platforms)
- Microsoft Windows 2000 Professional system (with the latest service packs)
- Microsoft Windows XP Professional system

The Microsoft Windows NT SP6 systems platform and the Sun Linux 5.0 and Red Hat Linux 7.2 operating environments are not supported for use with the Sun ONE Application Server 7.

Installing the Application Server

Before you can configure the IDE to use the Sun ONE Application Server 7, the application server must be installed, either locally (on the same system as the IDE) or remotely (on a separate machine). To download the application server, go to http://sun.com/software/products/appsrvr/appsrvr_download.html. Installation information is available from http://docs.sun.com/source/816-7145-10/.
You can select either evaluation or non-evaluation installation. The type you choose affects how you obtain the required plug-in module to connect to the IDE.

- **Evaluation installation**, designed for “try and buy” users, installs the application server, sample applications and database, and the J2SE SDK, v. 1.4.0_02 software
- **Non-evaluation installation**, designed for developers and system administrators, allows selective installation of components

---

**Connecting the IDE to the Application Server**

Two items are required for the IDE to connect to the Sun ONE Application Server 7 software for the purposes of deployment:

- A server plug-in module
- Administrative client libraries

The plug-in consists of a series of JAR and configuration files that are installed in either the IDE’s home directory or your IDE user directory. You can install this either from the IDE’s Update Center or by the Sun ONE Application Server 7 non-evaluation installer.

---

**Note** – The Sun ONE Application Server 7 Plug-in module uses the APIs from J2SE version 1.4.0_02. If the application server is started with other versions of the software (for instance, J2SE v.1.3.1), you cannot install the Sun ONE Application Server 7 Plug-in module.

The administrative client libraries consist of JAR files that support the server’s administrator. These files must be available on the same machine as the IDE. These files are installed with the Sun ONE Application Server 7 distribution. If the IDE is on a different machine from the application server, these files can also be installed on the IDE’s machine by the Sun ONE Application Server 7 non-evaluation installer.
TABLE 7-1 shows the installation options for the plug-in module and administrative client libraries, given the location of the IDE and application server installations. This chapter describes how to install the plug-in module from the Update Center. See the Sun ONE Application Server 7 tutorial (at http://docs.sun.com/source/816-7146-10/) for other options.

<table>
<thead>
<tr>
<th>Location of IDE and Application Server</th>
<th>Location of Admin Client Files</th>
<th>Installation Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>On same machine</td>
<td>In application server distribution (on same machine as the IDE)</td>
<td>• Install plug-in module from the Update Center</td>
</tr>
</tbody>
</table>
| On separate machines                   | In application server distribution (on separate machine from the IDE) | Either of these:  
  • Install plug-in module with non-evaluation installer  
  • Install application server on client machine |

## Installing and Configuring the Application Server Plug-in Module in the IDE

Download the Sun ONE Application Server 7 plug-in module from the IDE’s Update Center. See “Updating Modules With the Update Center” on page 87 for information on how to download Sun ONE Studio 4 modules. In the Update Center wizard, expand the Enterprise Edition Modules node to locate the Sun ONE Application Server 7 plug-in module.

After you have installed the application server’s plug-in module, you must make the Sun ONE Application Server 7 the default application server, as follows:

1. In the Sun ONE Studio 4 IDE, click the Explorer’s Runtime tab.
2. Expand the Server Registry node and its Installed Servers subnode.
3. Right-click the Sun ONE Application Server 7 node and choose Properties. The Properties window appears for this node.
4. Locate the Sun ONE App Server Home property and click its ellipsis button. A file browser window appears.
5. Use the browser to select the installation directory of the Sun ONE Application Server 7.
   For example, c:\Sun\AppServer7

6. Click OK to close the file browser and close the Properties window.

7. Right-click the Sun ONE Application Server 7 node again and choose Add Admin Server from the contextual menu.
   The Add Admin Server dialog box appears.

8. Type the host name in the Admin Server Host field.
   If the application server is on the same machine as the IDE, type localhost. If the server is remote, type the host name of the remote machine.

9. Type your admin port number in the Admin Server Port field, your server user name in the User Name field, and your server password in the User Password field.
   During the installation of the Sun ONE Application Server, the following values were suggested for these fields:
   - Admin Server Port: 4848
   - Admin User Name: admin
   - Admin User Password: (your choice)
   If you did not use these defaults, specify the values that you did use. If you don’t know the values to use, consult the Getting Started with Sun ONE Application Server 7 at http://docs.sun.com/source/816-7146-10 for instructions on where to look for this information.

10. Click OK to close the dialog box.
    This action creates a node labeled hostname:admin-server-port. This node represents the admin server. When you issue commands with this node, the admin server executes them. This action also creates an instance of the application server and a node that represents it. The node is a subnode of the Admin Server node, labeled server1(hostname:admin-server-port).

11. Expand the Sun ONE Application Server 7 node and its new hostname:admin-server-port subnode.

12. Right-click the server1(hostname:admin-server-port) instance node and choose Set As Default.
    You are now able to use the Sun ONE Application Server 7 application to deploy your applications.
Using Application and Web Servers
With the Sun ONE Studio 4 IDE

Once you have successfully installed the IDE and validated the IDE installation by creating a simple J2EE application (see Chapter 5 for more information), you can use other application servers with the IDE.

This chapter contains information about using the BEA WebLogic Server 6.1 or BEA WebLogic Server 7.0 as the default application server for applications you develop with the Sun ONE Studio 4 IDE. The chapter also provides details on how to configure several application and web servers for use with web services.

**Note** – Download the WebLogic Server Plug-in module from the Update Center before you proceed with the rest of this chapter. See “Updating Modules With the Update Center” on page 87 for information on how to download Sun ONE Studio 4 modules. In the Update Center wizard, expand the Enterprise Edition Modules node to locate the WebLogic Server Plug-in module.

Setting Up the WebLogic Environment

**Note** – WebLogic servers 6.1 and 7.0 require version 1.3.1 of the Java runtime environment (JRE). You must run the IDE with JRE 1.3.1 if you intend to deploy applications to the WebLogic server 6.1. Do not run the IDE and WebLogic servers with the J2SE, v. 1.4 platform or with the JRE, v. 1.4.

The WebLogic server must be running before you can deploy an application to it. However, before you start the application server, you must ensure that the WebLogic environment is set up correctly.
Note – If you deploy a J2EE application client to the WebLogic server, the server must be able to download its XML document definitions from the WebLogic web site. If your connection to the web requires a proxy server, specify this setting in the IDE before deploying an application to the WebLogic server. To set the proxy server, choose Tools → Setup Wizard and specify your proxy and web browser settings in the General Sun ONE Studio 4 Settings pane of that wizard.

Setting the BEA WebLogic Server as the Default Application Server

The BEA WebLogic server (versions 6.1 SP2 and 7.0) has been certified with this release of the Sun ONE Studio 4 IDE and is certified to run only with the Java 2 SDK, v. 1.3.1 software.

Follow these steps to make the WebLogic server the default application server for applications you create and deploy in the IDE.

1. Start the IDE.
   See Chapter 4 for instructions on how to start the IDE.

2. In the Explorer window, select the Runtime tab and expand the Server Registry/Installed Servers node.
   The WebLogic Server 6.1 node and the WebLogic Server 7.0 node are visible. You can configure and use either or both of the WebLogic servers.

3. Right-click the appropriate WebLogic Server node and choose Properties.
   The property sheet for the designated WebLogic server appears.

4. Set the value for the WebLogic Home property.
   a. Select the WebLogic Home property.
   b. For WebLogic Server 6.1, type `weblogic-install-dir/wlserver6.1` and close the property sheet.
   c. For WebLogic Server 7.0, type `weblogic-install-dir/weblogic700` and close the property sheet.

5. Add a WebLogic server instance by right-clicking the appropriate WebLogic Server node and choosing Add Server Instance.

6. Set the password value in the property sheet.
a. Right-click the WebLogic server instance you just created and choose Properties.

The property sheet for the instance appears.

b. Select the Password property and type the password you specified during the WebLogic server installation as the property’s value.

c. For WebLogic Server 7.0, set the RootDirectory property to the location of the server’s config.xml file. For example, weblogic-install-dir/user_projects/mydomain

d. Close the property sheet.

7. Right-click the WebLogic Server Instance 1 and choose Set As Default Application Server.

The WebLogic server is now the default application server used by the IDE.

---

**Note** – WebLogic Server 7.0 requires that the data sources for CMP beans are TxDataSources rather than DataSources. This requirement differs from WebLogic Server 6.1 requirements and is indicated by a message when the application is deployed to the WebLogic Server 7.0. For more information, see the BEA web site at [http://edocs.bea.com/wls/docs70/faq/jdbc.html](http://edocs.bea.com/wls/docs70/faq/jdbc.html).

---

Starting the WebLogic 7.0 Server From the Sun ONE Studio 4 IDE

To start the WebLogic 7.0 Server from the IDE, the following items must be provided from the Runtime tab of the Explorer:

- Extra JDBC/CLASSES required to start the WebLogic 7.0 server
  Examples would include Pointbase or Oracle JDBC drivers
- Extra libraries such as the .DLL/.so files required by the WebLogic 7.0 server

---

Configuring Application Servers for Use With Web Services

This section presents information on how to configure WebLogic Server 6.1 and WebLogic Server 7.0 to work with web services.
Note – To use Sun ONE Studio 4 Web Services, applications servers must be configured with version 1.0_01 or higher of the JAX-RPC (Java API for XML-Based RPC) runtime environment.

Starting Your WebLogic Server from the IDE

If you are using either WebLogic Server 6.1 or WebLogic Server 7.0 and you are starting the server from the IDE, you need to set the Startup Java Options property in the IDE.

1. In the Sun ONE Studio 4 IDE, click the Explorer’s Runtime tab.
2. Expand the Server Registry node and its Installed Servers subnode.
3. Expand the WebLogic Server node to see the instance nodes
4. Select the instance you want to change, right-click the WebLogic Server Instance node and choose Properties.
   The Properties window appears for this instance.
5. Locate the Startup Java Options property and enter the following string:
   -Djavaplugin.enabled=true

Starting Your WebLogic Server from Outside the IDE

These instructions are necessary only if you want to start the server from outside the IDE using the WebLogic startup script.

You need to do the following:
- Set the CLASSPATH environment variable.
- Set the JAVA_OPTIONS variable.

Setting the Class Path for WebLogic Server 6.1

If you are using the WebLogic Server 6.1 and plan to start the server from outside the IDE, append the following .jar files to the CLASSPATH environment variable in the WebLogic server startup script:
- s1studio-install-directory/jwsdp/jwsdp-common-lib/jwsdp-common.jar
- s1studio-install-directory/jwsdp/common/lib/servlet.jar
Setting the Class Path for WebLogic Server 7.0

If you are using the WebLogic Server 7.0 and plan to start the server from outside the IDE, append the following .jar file to the CLASSPATH environment variable in the WebLogic server startup script:

`s1studio-install-directory/jwsdp/jwsdp-common-lib/jwsdp-common.jar`

You do not need the `servlet.jar` file for WebLogic Server 7.0.

Setting the WebLogic Server Java Options

To start either the WebLogic Server 6.1 or WebLogic Server 7.0 from outside the IDE using the WebLogic startup script, do the following:

1. Open the WebLogic startup script in an editor of your choice.
2. Add the following string to the JAVA_OPTIONS variable:
   
   `-Djavaplugin.enabled=true`

Configuring Web Servers for Use With Web Services

This section describes how to configure the Tomcat web server for use with web services and for use with the Native Connector interface.

Configuring the Tomcat Server

The internal Tomcat v. 4.0.1 server cannot be used to deploy web-centric web service applications created with the Sun ONE Studio 4 update 1 IDE. The Sun ONE Studio 4 update 1 web services are created using JAX-RPC v. 1.0_01, which requires use of the Tomcat v. 4.1 server.

The IDE bundles the Java Web Services Developer Pack (Java WSDP) v. 1.0_01 software, which includes a Tomcat v. 4.1 server. Configuring this Tomcat v. 4.1 server as the default enables you to deploy Sun ONE Studio 4 update 1 web-centric web services properly.

Establish a user-specific configuration for the Tomcat server by doing the following:
1. Working outside the IDE, open a terminal window and go to the following directory:

   s1studio-install-directory/jwsdp/bin

   Find the ant file and verify that you have permission to execute the file. If you do not, ask your system administrator to give you execute permission to the ant file. Verify that your JAVA_HOME variable is set to your JDK version.

2. Run the following script:

   s1studio-install-directory/jwsdp/bin/ant -buildfile tomcat41-multiuser.xml -Dide.user.dir=s1studio-user-directory

   Install the Java WSDP Tomcat v. 4.1 server by doing the following:

   1. In the Sun ONE Studio 4 IDE, click the Explorer’s Runtime tab.
   2. Expand the Server Registry node and its Installed Servers subnode.
   3. Right-click the Tomcat 4.0 node and choose Add Tomcat 4.0 Installation.
      The Add Tomcat 4.0 Installation dialog box appears.
   4. Use the browser to set the Home directory and the Base directory of the Tomcat server.
      Set the Home directory to s1studio-install-directory/jwsdp
      Set the Base directory to s1studio-user-directory/jwsdp
   5. Specify IDE Integration Mode as Minimum.

      Note – Specifying the IDE Integration Mode as Minimum disables JSP debugging and monitoring features.

   6. Click OK to close the Add Tomcat 4.0 Installation dialog box.
      A new subnode appears in the Explorer Runtime window.
   7. Expand the new Java WSDP Tomcat subnode (under the Tomcat 4.0 node).
   8. Right-click the localhost:8080 subnode.
   9. Select Set as Default.
      You might see an informational message “JSP compilation will be disabled.” Click OK.

      Web-centric services can now automatically use the Tomcat v. 4.1 server for deployment. Newly created web-centric services also have their SOAP URLs automatically set to localhost:8080 as the port address.
For web-centric web services created before installation of the Tomcat v. 4.1 server, reset the port address to 8080.

**Note** – When you run web applications that do not use web services, you can use the default Tomcat 4.0 server.

Configuring Web Servers for Use With Native Connector Web Services

Web servers can host web-centric web service applications that use the Native Connector Tool. These services provide integration with native language shared libraries (that is, C++ and C). To locate the required shared libraries, you might have to configure the web servers to which these applications are deployed.

To access native libraries from web-centric web services, perform the following steps:

1. **Select or create a directory where these native library files are to be deployed.**
   This directory must be on a filesystem that is accessible to the Tomcat 4.1 web server process. For example, `s1studio-user-directory/nativelib` is a likely choice.

2. **In the Sun ONE Studio 4 IDE, click the Explorer’s Runtime tab.**

3. **Expand the Server Registry node and its Installed Servers subnode and find the Tomcat 4.1 server.**

4. **Right-click the Tomcat 4.1 server. Choose Properties.**

5. **Select the External Execution Process property and click the ellipsis (...) button in the right column of the property sheet.**
   The property editor window opens.

6. **In the Arguments edit box, insert the following prior to the \texttt{\-classpath} argument (using the directory you chose in step 1):**
   \texttt{-Djava.library.path=s1studio-user-directory/nativelib}
   Be sure to leave a space between this and the \texttt{\-classpath} specification.

7. **Click OK and close the property editor.**
Where to Go From Here

This chapter contains information about available documentation resources and how to obtain IDE updates from the Sun ONE Studio Update Center.

Updating Modules With the Update Center

Once you have Sun ONE Studio 4, Enterprise Edition for Java installed in your system, use the Update Center to add new IDE modules or update the existing IDE modules already installed in your system. Use the following steps to update your IDE:

1. Start the IDE.
   
   See Chapter 4 for instructions on how to start the IDE.

2. Select the Update Center from the IDE’s Welcome screen or choose Tools → Update Center from the main window of the IDE.
   
   The Update Center wizard appears.

3. Select Sun ONE Studio 4 Update Center as the Update Center, and deselect NetBeans Update Center.

4. Click the Proxy Configuration to set your proxy configuration, if needed.
   
   The Proxy Configuration dialog box appears. Modify the values as needed and click OK to return to the Update Center wizard.
5. Click Next, and type your Sun ONE Studio 4 Update Center login name and password.

See Step 11 in “Setting Up Your Sun ONE Studio 4 IDE” on page 55 for information on registering and creating a login name and password.

The Update Center displays the modules that are available to you.

6. Select individual modules or select all by clicking the >> button. Use the < button to remove those versions that are not appropriate to your platform.

7. Click Next and follow the Update Center installation procedure.

The IDE installs the selected modules and then restarts itself.

For more information about how the Update Center works and Sun’s privacy policy regarding your personal information, see the Developer Resources Site FAQs at http://forte.sun.com/ffj/feedback/sitefaq.html.

Other Documentation Resources

You can access the following resources to learn more about the different features of the IDE and how to use them:

■ The online help is available by accessing the Help menu from the main window of the IDE. You can view the available help sets by choosing Help Sets from the Help menu.


■ The Sun ONE Studio 4 Developer Resources site at http://forte.sun.com/ffj/index.html also contains a wealth of information and support resources, including Sun ONE Studio news, technical articles, a support knowledge base, forums, and more.

You can also access this site from the IDE by choosing Help → Web Resources from the main window of the IDE.
CHAPTER 10

Troubleshooting

This chapter provides some troubleshooting hints to help you during the installation, startup, configuration, and use of the Sun ONE Studio 4 IDE.

Using the solaris_patch_installer

TABLE 10-1 describes some errors you might encounter during installation of Solaris patches using the solaris_patch_installer script.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The solaris_patch_installer aborted while attempting to apply one of the required Solaris patches on your system. | 1. Write down the patch ID of the last patch that the solaris_patch_installer tried to install.  
2. Obtain a newer revision of that patch from http://sunsolve.sun.com, if one is available.  
3. Install the new revision on your system using the patchadd utility. If you are unfamiliar with installing Solaris packages, contact your system administrator for assistance.  
4. Run the solaris_patch_installer again to ensure you have all the required Solaris 8 patches on your system. |
Receipt of an error message similar to the following, after running the `solaris_patch_installer` on a newly installed Solaris 8 (update 7) environment:

```
# ./solaris_patch_installer
Solaris Patch Installer for J2SE, v.1.4.0
Installing 109147-14... successfully installed
Installing 108434-06...
...
Installing 108528-13... attempting to patch a package that is not installed
Installing 108652-51... successfully installed
Installing 108921-13... already applied
Installing 108940-40... successfully installed
Installing 108773-12... pkgadd failed
Cannot continue patch installation.
For more details, please look at /var/tmp/solaris_patch_installer.log
```

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of an error message similar to the following, after running the <code>solaris_patch_installer</code> on a newly installed Solaris 8 (update 7) environment:</td>
<td>Run the <code>solaris_patch_installer</code> script a second time. If you continue to have problems, contact your Solaris system administrator.</td>
</tr>
</tbody>
</table>
TABLE 10-2 describes some errors you might encounter during the Sun ONE Studio 4 IDE installation.

<table>
<thead>
<tr>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of the following error message while installing the Sun ONE Studio 4 IDE: Error writing file = There may not be enough temporary disk space. Try using -is:tempdir to use a temporary directory on a partition with more disk space</td>
</tr>
<tr>
<td>Solution</td>
</tr>
<tr>
<td>Start the installer with the -is:tempdir command-line option in order to specify a directory on a disk with more free space. For example, in a Solaris operating environment, you might type the following at the command prompt: $ ffj_ee_solsparc_en.bin -is:tempdir temporary-directory</td>
</tr>
<tr>
<td>The Sun ONE Studio 4 installer fails and displays a message that there is not enough available disk space to use for installation. However, the filesystem you specified to use for installing the IDE has plenty of available disk space.</td>
</tr>
<tr>
<td>Solution</td>
</tr>
<tr>
<td>Determine if the filesystem you have specified is symbolically linked to another filesystem whose disk space is not recognized. For example, in a Solaris environment, /export/home has 2 GB of space and / has 100 MB. The /opt directory is symbolically linked to /export/home. If you specified /opt/s1studio as the IDE installation directory, the Sun ONE Studio 4 installer does not recognize the symbolic link to /export/home, which has 2 GB of available disk space. The installer recognizes only the / directory, which is the target directory for /opt and has only 100 MB. To correct the problem, directly specify the filesystem with the larger available disk space. For the preceding example, specify /export/home as the installation directory.</td>
</tr>
<tr>
<td>Receipt of the following error message while installing the Sun ONE Studio 4 IDE: Error: Could not find JVM</td>
</tr>
<tr>
<td>Solution</td>
</tr>
<tr>
<td>Start the installer with the -is:javahome command-line option, in order to guide the installer as to where the JDK is installed. For example, in a Solaris operating environment, type the following at the command prompt: $ ffj_ee_solsparc_en.bin -is:javahome javahome</td>
</tr>
</tbody>
</table>
(Solaris or Linux environments only) The Sun ONE Studio 4 installer looks like it has hung, after startup. No messages are displayed.

Ensure that you have set the DISPLAY environment variable correctly. If you are installing on your local system, the DISPLAY environment variable should be set to :0.0.

If you are using a superuser (root) account or performing a remote installation, set your DISPLAY environment variable to your local system.

For example, to set the DISPLAY variable from a root account that is using a C shell, type the following in the command window you used to log into the root account:

```
setenv DISPLAY your-local-host:0.0.
```

Run the installer again from the same command window.

The Sun ONE Studio 4 IDE installer exits without installing the product. No messages are displayed.

Here are the possible causes and solutions:

- The file you have downloaded from the Sun ONE Studio 4 product download page is not complete. Download the file again, and check that the size of the downloaded file is the same as the file size specified on the product download page. Run the IDE installer again.
- You have specified an invalid command-line parameter in the installer.sp file. Check the file and correct any incorrect command-line parameter setting. Run the IDE installer again.
- Run the installer launcher (<installer>.exe file or <installer>.bin file) with the option `<installer>.exe/bin -is:log log.txt`. Check log.txt for possible errors.

The -is:tempdir command-line parameter is not working.

Ensure that you are using the correct syntax for the command-line parameter for the installer. For example, in a Solaris environment, the syntax is as follows:

```
ffj_ce_solsparc_en.bin -is:tempdir temporary-directory
```

If you have inserted the product CD on a computer running in the Solaris 7 operating environment, receipt of error message that the product is not supported for the Solaris 7 operating environment.

Sun ONE Studio 4 IDE is only supported in the Solaris 8 and 9 operating environments.

---

**TABLE 10-2 Sun ONE Studio 4 IDE Installation Errors (Continued)**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Solaris or Linux environments only) The Sun ONE Studio 4 installer looks like it has hung, after startup. No messages are displayed.</td>
<td>Ensure that you have set the DISPLAY environment variable correctly. If you are installing on your local system, the DISPLAY environment variable should be set to :0.0. If you are using a superuser (root) account or performing a remote installation, set your DISPLAY environment variable to your local system. For example, to set the DISPLAY variable from a root account that is using a C shell, type the following in the command window you used to log into the root account: <code>setenv DISPLAY your-local-host:0.0</code>. Run the installer again from the same command window.</td>
</tr>
</tbody>
</table>
| The Sun ONE Studio 4 IDE installer exits without installing the product. No messages are displayed. | Here are the possible causes and solutions:  
- The file you have downloaded from the Sun ONE Studio 4 product download page is not complete. Download the file again, and check that the size of the downloaded file is the same as the file size specified on the product download page. Run the IDE installer again.  
- You have specified an invalid command-line parameter in the installer.sp file. Check the file and correct any incorrect command-line parameter setting. Run the IDE installer again.  
- Run the installer launcher (<installer>.exe file or <installer>.bin file) with the option `<installer>.exe/bin -is:log log.txt`. Check log.txt for possible errors. |
| The -is:tempdir command-line parameter is not working. | Ensure that you are using the correct syntax for the command-line parameter for the installer. For example, in a Solaris environment, the syntax is as follows: `ffj_ce_solsparc_en.bin -is:tempdir temporary-directory` |

---
(Solaris environment only) Receipt of the following error message: `Cannot find product /product.xml on your computer.`

Stop and start volume management (vold) on the system, and run the installer again.

1. Ensure that media are not being used.
2. Become superuser.
3. Type the `volmgt stop` command:
   ```
   # /etc/init.d/volmgt stop
   #
   ```

To restart volume management:

1. Become superuser.
2. Type the `volmgt start` command:
   ```
   # /etc/init.d/volmgt start
   ```

(Solaris environment only) Not able to eject the product CD when running the installer manually. (This problem occurs when you are installing the IDE from the merged product CD. Hence, two CD-ROMs are involved in the installation.)

When running the installer manually, do not run it from within its own directory.

When you install the IDE and start it up, you create a user directory. If you install the bundled Sun ONE Application Server 7 and Sun ONE Studio 4 IDE and start it up, it looks at the registry and attempts to adjust to the modules and settings in this previously-created user directory.

Start the second installation of the IDE (the installation that is embedded in the Sun ONE Application Server 7) using the command line and specifying a different user directory.

### Table 10-2  Sun ONE Studio 4 IDE Installation Errors (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Solaris environment only) Receipt of the following error message:</td>
<td>Stop and start volume management (vold) on the system, and run the installer again.</td>
</tr>
<tr>
<td><code>Cannot find product /product.xml on your computer.</code></td>
<td>To stop volume management:</td>
</tr>
<tr>
<td></td>
<td>1. Ensure that media are not being used.</td>
</tr>
<tr>
<td></td>
<td>2. Become superuser.</td>
</tr>
<tr>
<td></td>
<td>3. Type the <code>volmgt stop</code> command:</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td># /etc/init.d/volmgt stop</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>To restart volume management:</td>
</tr>
<tr>
<td></td>
<td>1. Become superuser.</td>
</tr>
<tr>
<td></td>
<td>2. Type the <code>volmgt start</code> command:</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td># /etc/init.d/volmgt start</td>
</tr>
<tr>
<td>(Solaris environment only) Not able to eject the product CD when running</td>
<td>When running the installer manually, do not run it from within</td>
</tr>
<tr>
<td>the installer manually. (This problem occurs when you are installing</td>
<td>its own directory.</td>
</tr>
<tr>
<td>the IDE from the merged product CD. Hence, two CD-ROMs are involved in</td>
<td></td>
</tr>
<tr>
<td>the installation.)</td>
<td></td>
</tr>
<tr>
<td>When you install the IDE and start it up, you create a user directory.</td>
<td>Start the second installation of the IDE (the installation that is</td>
</tr>
<tr>
<td>If you install the bundled Sun ONE Application Server 7 and Sun ONE</td>
<td>embedded in the Sun ONE Application Server 7) using the command line</td>
</tr>
<tr>
<td>Studio 4 IDE and start it up, it looks at the registry and attempts to</td>
<td>and specifying a different user directory.</td>
</tr>
<tr>
<td>adjust to the modules and settings in this previously-created user</td>
<td></td>
</tr>
<tr>
<td>directory.</td>
<td></td>
</tr>
</tbody>
</table>
TABLE 10-3 describes some errors you might receive during startup and configuration of the newly installed Sun ONE Studio 4 IDE software.

### TABLE 10-3 Sun ONE Studio 4 IDE Startup and Configuration Errors

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of an error message similar to the following during the IDE startup in a supported Solaris environment: Error: Java 2 SDK search failed to find a suitable J2SDK!</td>
<td>Reinstall the SDK logged in as superuser and ensure that the installation directory is on the root level.</td>
</tr>
<tr>
<td>Receipt of an error message similar to the following during the IDE startup in a supported Solaris environment: Error: No J2SE was found at /usr/j2se/bin/java ERROR: The following required 5.8 patches have not been installed on system “myserver”: 106950-16 106327-11 106541-17</td>
<td>Install the J2SE, v. 1.4.0 platform on your system. For a Solaris 8 operating environment, include any necessary patches. Refer to Chapter 2 for more information on installing this software on your system.</td>
</tr>
<tr>
<td>Receipt of the following error message after starting the IDE: Error: Unable to load java.dll</td>
<td>Ensure that there is no space in the name of the directory in which you have installed the J2SE, v. 1.3.1 or v. 1.4.0 platform. (This situation exists in Solaris and Linux environments.)</td>
</tr>
</tbody>
</table>
### Table 10-3  Sun ONE Studio 4 IDE Startup and Configuration Errors (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun ONE Studio 4 IDE is not pointing to the J2SE, v. 1.4.0 platform you had specified during the IDE installation and you receive an error message similar to the following: ERROR: The J2SE[tm] 1.2.1 found at /usr/java1.2/bin/java cannot be used by the IDE. J2SE[tm] 1.4 is recommended. NOTE: You can download and install the J2SE[tm] and related Solaris[tm] patches from <a href="http://access1.sun.com/forte/">http://access1.sun.com/forte/</a>. Warning:Current runtime environment does not satisfy minimum requirements.</td>
<td>Check the Java environment variables already set prior to starting the IDE and unset them. The values of the $JAVA_PATH and $JDK_HOME environment variables override the value of the J2SE SDK path you specified during the IDE installation. You need to unset these environment variables or use the -jdkhome command-line option when starting the IDE.</td>
</tr>
<tr>
<td>The user directory is created in the wrong location in a Microsoft Windows system.</td>
<td>If you have previously installed any edition of the Sun ONE Studio 4 IDE in a Microsoft Windows environment, the location of the user directory is recorded in the Microsoft Windows Registry under HKEY_CURRENT_USER/Software/Sun Microsystems, Inc./Forte for Java/EE/4.0. This value is not deleted when you uninstall the Sun ONE Studio 4 IDE. Therefore, when you install another version of the Sun ONE Studio 4 IDE, the user directory specified in a previous Sun ONE Studio 4 IDE installation is reused. If you want to use a different location for the user directory, do the following: 1. Uninstall the Sun ONE Studio 4 IDE. 2. In a command window, type regedit to start the Microsoft Windows Registry editor. 3. From the Registry editor, expand the HKEY_CURRENT_USER registry and the keys for Software/Sun Microsystems, Inc./Forte for Java/EE/4.0 4. Right-click the UserDir value and choose Delete from the contextual menu. 5. Install the Sun ONE Studio 4 IDE again. 6. After installation, start the Sun ONE Studio 4 IDE and when you are prompted, specify a new location for the user directory.</td>
</tr>
<tr>
<td>(Solaris environment only) Not able to eject the product CD when running the installer manually. (This problem occurs when you are installing the IDE from the merged product CD. Hence, two CD-ROMs are involved in the installation.)</td>
<td>Do not attempt to run the installer from within its own directory.</td>
</tr>
</tbody>
</table>
## Running Web Services

TABLE 10-4 describes some error messages you might get when running a web service using any of the application servers supported by the IDE.

### TABLE 10-4  Errors When Running a Web Service With Any Application Server

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of the following exception:</td>
<td>The Web Context property of the web module in the J2EE application does not match the context root specified in the SOAP RPC URL property of the web service. To obtain the Web Context property of the web module:</td>
</tr>
<tr>
<td>[SOAPException: faultCode=SOAP-ENV:Client; msg=Connection shutdown: JVM_recv in socket input stream read; targetException: java.net.SocketException: Connection shutdown: JVM_recv in socket input stream read]</td>
<td>1. Expand the J2EE application to which the web service was added. \n2. Right-click the web module of the web service (this is the file whose name ends in _War) and choose Properties. \n3. The Web Context property is one of the properties displayed in the Properties window. \nThe first instance of MyService in this URL is the context root or web context. You can change it to any value of your choice, but it must match the value of the Web Context property of the web module in the J2EE application.</td>
</tr>
<tr>
<td>Receipt of the following exception:</td>
<td>Changes were made to the web service, and you did not refresh the web service client that was making the call to the web service. To refresh the web service client:</td>
</tr>
<tr>
<td>[SOAPException: faultCode=SOAP-ENV:Client; msg=Error opening socket: Connection refused: connect; targetException: java.lang.IllegalArgumentException: Error opening socket: Connection refused: connect]</td>
<td>1. Right-click the web service client node to display its contextual menu. \n2. Choose Refetch WSDL. This regenerates the client proxy to reflect the changes made to the web service.</td>
</tr>
</tbody>
</table>
Receipt of the following exception in the IDE output window when deploying a web-centric web service:

```java
StandardContext[/yourService]: Error configuring application listener of class
com.sun.xml.rpc.server.http.JAXRPCContextListener
java.lang.ClassNotFoundException: com.sun.xml.rpc.server.http.JAXRPCContextListener ...

StandardContext[/yourService]: Skipped installing application listeners due to previous error(s)
StandardContext[/yourService]: Context startup failed due to previous errors
```

The internal Tomcat v. 4.0.1 server cannot be used for the deployment of web-centric web services created by the Sun ONE Studio 4 update 1 IDE. Refer to “Configuring Web Servers for Use With Web Services” on page 83 for more information.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of the following exception in the IDE output window when deploying a web-centric web service:</td>
<td>The internal Tomcat v. 4.0.1 server cannot be used for the deployment of web-centric web services created by the Sun ONE Studio 4 update 1 IDE. Refer to “Configuring Web Servers for Use With Web Services” on page 83 for more information.</td>
</tr>
</tbody>
</table>
# Web Services Using UDDI

TABLE 10-5 describes some error messages you might get when running a web service using UDDI.

**TABLE 10-5  Errors When Running a Web Service Using UDDI**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of an empty web page when viewing .wsdl files.</td>
<td>Many versions of the Netscape web browser do not display the .wsdl file. View the page’s source file to see the actual .wsdl file.</td>
</tr>
</tbody>
</table>
| Receipt of the following exception when searching for anything in a UDDI registry using the New Client wizard: IllegalArgumentException | If you intend to use UDDI, you need to set the User Proxy Server name and port information when you first run the Sun ONE Studio 4 IDE. You can use either of the following to set the User Proxy Server information:  
  - When you start the IDE after installation, specify the User Proxy Server name and port from the second dialog box.  
  - Choose Tools → Setup Wizard from the main window of the IDE and provide the User Proxy Server name and port. You must restart the IDE for the values to take effect. |
| Receipt of the following exception in the registry server Tomcat output window when inquiring or publishing to the internal UDDI server:  
  `[WARN] registry_server -- org.xmldb.api.base.XMLDBException while connecting: org.apache.xnode.XNodeException: aborting connection attempt.` | A possible cause is that a previous Xindice server instance was not gracefully terminated. (On a Microsoft Windows system, you might have to restart the operating system to get rid of these server instances.)  
  1. Terminate the corresponding Java processes associated with that Xindice server instance.  
  2. Restart the IDE.  
  Always terminate the internal UDDI registry server using the following steps:  
  1. Select the Runtime tab of the Explorer.  
  2. Expand the UDDI Server Registry node.  
  3. Right-click the Internal UDDI Registry and choose Stop Server from the contextual menu. |
Using WebLogic Servers 6.1 or 7.0

TABLE 10-6 describes some error messages you might get when using WebLogic Server 6.1 or 7.0.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebLogic Server is unable to download its XML document definitions from the BEA web site.</td>
<td>If you deploy a J2EE application client to the WebLogic Server, the server must be able to download its XML document definitions from the WebLogic web site. If your connection to the web requires a proxy server, you specify this setting in the IDE before deploying an application to the WebLogic server. To set the proxy server, choose Tools → Setup Wizard and specify your proxy and web browser settings in the General Sun ONE Studio 4 Settings pane of that wizard.</td>
</tr>
<tr>
<td>Receipt of error running web service application deployed to WebLogic Server: http - -no endpoint specified exception</td>
<td>If you are starting the WebLogic 6.1 or 7.0 server from the IDE, add the following value to the Startup Java Options property for the server instance: -Djavaplugin.enabled=true If you are starting the server using the WebLogic startup script, add the same value to the JAVA_OPTIONS variable.</td>
</tr>
</tbody>
</table>
Using J2EE Reference Implementation 1.3.1

TABLE 10-7 describes some error messages you might get when using J2EE Reference Implementation 1.3.1.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of the following error in your browser after deploying the HelloWorld J2EE application (see “Creating a HelloWorld J2EE Application” on page 63): ERROR: The requested URL could not be retrieved. While trying to retrieve the URL: <a href="http://localhost:8000/helloTest_TestApp/dispatch.jsp">http://localhost:8000/helloTest_TestApp/dispatch.jsp</a> the following error was encountered: Connection Failed.</td>
<td>If your system is behind a firewall, ensure that your browser is configured to not use proxy servers for domains beginning with localhost.</td>
</tr>
<tr>
<td>Receipt of the following error message: org.omg.CORBA.INTERNAL: minor code: 1398079697 completed: No ... java.lang.RuntimeException: Unable to create ORB. Possible causes include TCP/IP ports in use by another process ... Error executing J2EE server...</td>
<td>This error occurs when another process is already using the 1050 listen port. You can either shut down the other process or change the port number assigned to J2EE Reference Implementation 1.3.1 to something other than 1050, for example, 11050. This error can also occur if the 1060 listen port is in use, even if the 1050 port is not in use. Do the following to correct the problem: 1. Determine whether the 1050 port, the 1060 port, or both are in use. 2. Change whichever port is in use. To change the 1050 port assignment, you must modify the $J2EE_HOME/config/orb.properties file. To change the 1060 port assignment, use a text editor to modify the $J2EE_HOME/setenv.bat (for Microsoft Windows systems), or $J2EE_HOME/bin/setenv.sh file (for Solaris or Linux environments).</td>
</tr>
</tbody>
</table>
**TABLE 10-7** Errors When Using J2EE Reference Implementation 1.3.1 (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of an error message similar to the following:</td>
<td>This error occurs if either the 7000 or 8000 web server port is in use. Set the http.port or https.port properties in the $J2EE_HOME/config/web.properties file to a different web server port.</td>
</tr>
<tr>
<td>Starting web service at port:8000</td>
<td></td>
</tr>
<tr>
<td>Starting secure web service at port: 7000</td>
<td></td>
</tr>
<tr>
<td>J2EE SDK/1.3.1 LifecycleException: null.open:</td>
<td></td>
</tr>
<tr>
<td>java.net.BindException: Address in use: JVM_Bind</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Error executing J2EE server...</td>
<td></td>
</tr>
<tr>
<td>Receipt of an error message similar to the following:</td>
<td>This error occurs if the 9191 EJB server port is in use. Modify the $J2EE_HOME/config.ejb.properties file to use a different EJB server port.</td>
</tr>
<tr>
<td>Starting web service at port:8000</td>
<td></td>
</tr>
<tr>
<td>Starting secure web service at port:7000</td>
<td></td>
</tr>
<tr>
<td>J2EE SDK/1.3.1</td>
<td></td>
</tr>
<tr>
<td>Starting web service at port:9191</td>
<td></td>
</tr>
<tr>
<td>J2EE SDK/1.3.1 LifecycleException: null.open:</td>
<td></td>
</tr>
<tr>
<td>java.net.BindException: Address in use: JVM_Bind</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Error executing J2EE server...</td>
<td></td>
</tr>
<tr>
<td>Receipt of ClassNotFoundException when deploying an application using</td>
<td>This problem might occur if you installed the IDE to run with the Java 2 SDK, v. 1.3.1, and you started the IDE with the -jdkhome switch option set to a Java 2 SDK, v. 1.4.0 installation. Your application might compile, but you could receive the ClassNotFoundException at deployment time if you used a Java API that is specific only to Java 2 SDK, v. 1.4.0.</td>
</tr>
<tr>
<td>J2EE Reference Implementation 1.3.1.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note that the J2EE Reference Implementation 1.3.1 server is set to use the Java 2 SDK specified during the IDE installation and not the Java 2 SDK specified by the -jdkhome switch option.</td>
</tr>
<tr>
<td></td>
<td>Do one of the following to correct the problem:</td>
</tr>
<tr>
<td></td>
<td>• Edit the JAVA_HOME setting in the J2EE Reference Implementation startup file to use the desired version of the Java 2 SDK. The setting is found in $J2EE_HOME/bin/userconfig.sh in Solaris and Linux environments or in the $J2EE_HOME/bin/userconfig.bat file on Microsoft Windows systems.</td>
</tr>
<tr>
<td></td>
<td>• Use a comparable Java API from the Java 2 SDK, v. 1.3.1 platform.</td>
</tr>
</tbody>
</table>
Receipt of the following exception:
java.lang.RuntimeException: Could not initialize j2ee server

This error occurs if another application has already taken the port number that the J2EE Reference Implementation server is trying to use. You can reboot the J2EE Reference Implementation server to get the port number before the other application does, or troubleshoot the error by following these steps:

1. Open your
   `$J2EE_HOME/config/orb.properties` file and make a note of the port number.

2. Use the `netstat` command to see if the number is in use. For example, in a Solaris operating environment, type something similar to the following in a command window:
   ```
   netstat -a | grep port-number
   ```

3. If the number is in use by another process, you need to change the port being used by the J2EE Reference Implementation server or by the other process. To find a free port, try running the `netstat` command again and remove the last couple of digits of the `port-number`. For example, in a Solaris environment, you might type:
   ```
   netstat -a | grep 104
   ```
   This command lists all of the 104 ports in use. If there is a number missing, change the
   `$J2EE_HOME/config/orb.properties` file to the number missing from the list.

---

**TABLE 10-7  Errors When Using J2EE Reference Implementation 1.3.1 (Continued)**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt of the following exception:</td>
<td>This error occurs if another application has already taken the port number that the J2EE Reference Implementation server is trying to use. You can reboot the J2EE Reference Implementation server to get the port number before the other application does, or troubleshoot the error by following these steps:</td>
</tr>
<tr>
<td>java.lang.RuntimeException: Could not initialize j2ee server</td>
<td>1. Open your <code>$J2EE_HOME/config/orb.properties</code> file and make a note of the port number.</td>
</tr>
<tr>
<td></td>
<td>2. Use the <code>netstat</code> command to see if the number is in use. For example, in a Solaris operating environment, type something similar to the following in a command window: `netstat -a</td>
</tr>
<tr>
<td></td>
<td>3. If the number is in use by another process, you need to change the port being used by the J2EE Reference Implementation server or by the other process. To find a free port, try running the <code>netstat</code> command again and remove the last couple of digits of the <code>port-number</code>. For example, in a Solaris environment, you might type: `netstat -a</td>
</tr>
</tbody>
</table>
# Solaris Patch Identifications and Descriptions

TABLE A-1 provides the patch identification numbers and patch descriptions included with the `solaris_patch_installer` for the Solaris 8 *SPARC Platform Edition*.

<table>
<thead>
<tr>
<th>Patch Identification Number</th>
<th>Patch Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>109147-14</td>
<td>Solaris 8 interprocedural optimizer</td>
</tr>
<tr>
<td>108434-06</td>
<td>Solaris 8 libC sparc</td>
</tr>
<tr>
<td>108435-06</td>
<td>V9 libC</td>
</tr>
<tr>
<td>111293-04</td>
<td><code>/usr/lib/libdevinfo.so.1</code></td>
</tr>
<tr>
<td>112334-01</td>
<td><code>/usr/include/sys/archsystem.h</code></td>
</tr>
<tr>
<td>111310-01</td>
<td><code>/usr/lib/libdhcpagent.so.1</code></td>
</tr>
<tr>
<td>108528-13</td>
<td>SIGEMT</td>
</tr>
<tr>
<td>108652-51</td>
<td>Xserver</td>
</tr>
<tr>
<td>108921-13</td>
<td>CDE 1.4 dtwm</td>
</tr>
<tr>
<td>108940-40</td>
<td>Motif 2.1</td>
</tr>
<tr>
<td>108773-12</td>
<td>X input methods</td>
</tr>
<tr>
<td>109607-01</td>
<td><code>/usr/include/iso/stdlib_iso.h</code></td>
</tr>
<tr>
<td>112003-03</td>
<td>Fontset</td>
</tr>
<tr>
<td>108989-02</td>
<td>Accounting</td>
</tr>
<tr>
<td>108827-17</td>
<td>Threads</td>
</tr>
</tbody>
</table>
Port Usage in the Sun ONE Studio 4 IDE

TABLE B-1 provides a listing of the ports used in the Sun ONE Studio 4, Enterprise Edition for Java IDE. It includes ports used by Sun ONE Studio 4 modules, third-party components, and application servers available for use with the IDE. Also included is information on whether the default port assignment can be modified and changes can be made.

Unless you are using multiple application servers or you are using the IDE in a multiuser environment, you should not encounter port conflicts.

<table>
<thead>
<tr>
<th>Names of Module, Application Server, or Third-Party Components</th>
<th>Default Port Number Assigned</th>
<th>Description</th>
<th>Information on Modifying Default Port Assignment</th>
</tr>
</thead>
</table>
| NetBeans Open File Module                                    | 7318                        | Open file server | The default port assignment can be modified using the properties editor for the Open File Server:  
  1. Choose Tools → Options from the main window of the IDE.  
  2. From the Options window, expand the IDE Configuration node.  
  3. Expand the Server and External Tool Settings node, right-click Open File Server, and choose Properties from the contextual menu.  
  4. Click the current value for Port property and type a different port number. |
| NetBeans Internal HTTP Server Module                         | 8082                        | Embedded server HTTP | The default port assignment is automatically changed if a conflict is detected. |
| External Editor                                              | 3219                        |                           | The default port assignment can be modified through the external editor’s options pane. |
TABLE B-1  Port Usage in the Sun ONE Studio 4, Enterprise Edition for Java IDE (Continued)

<table>
<thead>
<tr>
<th>Names of Module, Application Server, or Third-Party Components</th>
<th>Default Port Number Assigned</th>
<th>Description</th>
<th>Information on Modifying Default Port Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PointBase Restricted Edition</td>
<td>9092</td>
<td></td>
<td>The default port assignment can be modified in the PointBase initialization file, s1studio-user-directory/pointbase/pointbase.ini. Add the line: server.port=new-port-number.</td>
</tr>
<tr>
<td>Names of Module, Application Server, or Third-Party Components</td>
<td>Default Port Number Assigned</td>
<td>Description</td>
<td>Information on Modifying Default Port Assignment</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>----------------------------</td>
<td>-------------</td>
<td>--------------------------------------------------</td>
</tr>
</tbody>
</table>
| Tomcat 4.0.1                                                  | 8015 Server administration | The default port number can be modified using the properties editor for the internal Tomcat 4.0.1 server:  
1. On the Runtime tab of the Explorer, expand the Server Registry node and the Installed Servers node.  
2. Expand the Tomcat 4.0 node, right-click the Internal node, and choose Properties from the contextual menu.  
3. Click the current value for the Server Port property and type the desired port number. |
|                                                              | 8081 Server HTTP            | The default port number can be modified using the properties editor for the Host to be edited:  
1. On the Runtime tab of the Explorer, expand the Server Registry node and the Installed Servers node.  
2. Expand the Tomcat 4.0 node and expand the relevant installation node.  
3. Right-click the node representing the Host to be edited, and choose Properties from the contextual menu.  
4. Click the value for the HTTP Connector property field and type the desired port number. |
|                                                              | 8443 Redirecting            | You can modify the Tomcat configuration file, slstudio-user-dir/tomcat401_base/conf/server.xml.  
Be aware that you edit the server.xml file at your own risk. Be sure to create a backup version of your working server.html file before beginning to edit.  
1. On the Runtime tab of the Explorer, expand the Tomcat 4.0 node under the Installed Servers node.  
2. Right-click the node for the installation of Tomcat that you want to edit. From the contextual menu, choose Configure (server.xml).  
The server.xml file appears in the Source Editor. You can now edit server.xml to modify the default port number. |
|                                                              | 11555 IDE debugger connection | The default port number can be modified using the properties editor for the internal Tomcat 4.0.1 server:  
1. On the Runtime tab of the Explorer, expand the Server Registry node and the Installed Servers node.  
2. Expand the Tomcat 4.0 node, right-click the Internal node and choose Properties from the contextual menu.  
3. Select the Debugger tab.  
4. Click the current value for the Debugger Port property and type the desired port number. |
### TABLE B-1  Port Usage in the Sun ONE Studio 4, Enterprise Edition for Java IDE (Continued)

<table>
<thead>
<tr>
<th>Names of Module, Application Server, or Third-Party Components</th>
<th>Default Port Number Assigned</th>
<th>Description</th>
<th>Information on Modifying Default Port Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>J2EE Reference Implementation 1.3.1</td>
<td>1050</td>
<td>Naming service (ORB/IIOP)</td>
<td>Use a source editor of your choice to modify the orb.properties file found in the s1studio-user-directory/j2sdkee1.3.1/config directory. Change the default port number to another port number that is unused. The property is listed in the file as <code>port=1050</code> (the CORBA-based JNDI implementation port). NOTE: If you are using your own installation of RI (RI was not installed by the IDE installer), then replace <code>s1studio-user-directory</code> with your RI installation directory name.</td>
</tr>
<tr>
<td></td>
<td>1060</td>
<td>Secure Socket Port</td>
<td>Use a source editor of your choice to modify the file s1studio-user-directory/j2sdkee1.3.1/bin/j2ee.bat (for Microsoft Windows systems) or s1studio-user-directory/j2sdkee1.3.1/bin/j2ee (for Solaris and Linux environments). Modify the last four digits on the line that defines the LISTEN_OPTIONS environment variable.</td>
</tr>
<tr>
<td></td>
<td>8000</td>
<td>Web server (HTTP)</td>
<td>Use a source editor of your choice to modify the web.properties file found in the s1studio-user-directory/j2sdkee1.3.1/config directory. The property is listed as in the file as <code>http.port=8000</code>.</td>
</tr>
<tr>
<td></td>
<td>7000</td>
<td>Secure web server (HTTPS)</td>
<td>Use a source editor of your choice to modify the web.properties file found in the s1studio-user-directory/j2sdkee1.3.1/config directory. The property is listed in the file as <code>https.port=7000</code>.</td>
</tr>
<tr>
<td></td>
<td>9191</td>
<td>EJB service</td>
<td>Use a source editor of your choice to modify the ejb.properties file found in the s1studio-user-directory/j2sdkee1.3.1/config directory. The property is listed as <code>http.port=9191</code>.</td>
</tr>
</tbody>
</table>
### Table B-1: Port Usage in the Sun ONE Studio 4, Enterprise Edition for Java IDE (Continued)

<table>
<thead>
<tr>
<th>Names of Module, Application Server, or Third-Party Components</th>
<th>Default Port Number Assigned</th>
<th>Description</th>
<th>Information on Modifying Default Port Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Web Services Developer Pack UDDI Server (bundled with Sun ONE Studio 4, Enterprise Edition for Java)</td>
<td>8095</td>
<td>Tomcat server port for registry server</td>
<td>The default port assignment can be modified in <code>s1studio-user-dir/jwsdp/uddi_base/conf/server.xml</code> 1. Open the server.xml file in a text editor. 2. Replace the port number. 3. Restart the IDE.</td>
</tr>
<tr>
<td></td>
<td>8089</td>
<td>Tomcat HTTP port for registry server</td>
<td>The default port assignment can be modified in <code>s1studio-user-dir/jwsdp/uddi_base/conf/server.xml</code> 1. Open the server.xml file in a text editor. 2. Replace the port number. 3. Restart the IDE.</td>
</tr>
<tr>
<td></td>
<td>4070</td>
<td>Xinidce Gopher server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4080</td>
<td>Xinidce HTTP</td>
<td>The default port assignment can be modified in the <code>&lt;s1studio-user-dir/jwsdp/tools/xindice/config/system.xml</code> 1. Open the system.xml file in a text editor. 2. Replace the port number. 3. Restart the IDE.</td>
</tr>
<tr>
<td>WebLogic 6.1 or 7.0</td>
<td>7001</td>
<td>Server HTTP</td>
<td>The default port assignment can be modified during the installation of the WebLogic server.</td>
</tr>
<tr>
<td></td>
<td>7002</td>
<td>Server HTTPS</td>
<td>The default port assignment can be modified during the installation of the WebLogic server.</td>
</tr>
<tr>
<td>Sun ONE Application Server 7: Solaris Integrated and Solaris Supported Edition</td>
<td>4848</td>
<td>Server administration HTTP</td>
<td>Refer to the server installation documentation (<a href="http://docs.sun.com/source/816-7145-10/index.html">http://docs.sun.com/source/816-7145-10/index.html</a>) for details.</td>
</tr>
</tbody>
</table>